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TUYÊN BỐ BẢN QUYỀN 

Giáo trình Thiết kế và chế tạo mạch điện tử  dùng trong nhà trường với mục đích làm tài 

liệu giảng dạy cho giáo viên và học sinh, sinh viên nên các nguồn thông tin có thể được tham khảo. 

Giáo trình Thiết kế và chế tạo mạch điện tử  trường Cao đẳng kỹ thuật công nghệ Bà Rịa 

Vũng Tàu   in ấn và phát hành.  

Việc sử dụng tài liệu này với mục đích thương mại hoặc khác với mục đích trên đều bị 

nghiêm cấm và bị coi là vi phạm bản quyền. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



LỜI GIỚI THIỆU  

 

Trong chương trình đào tạo nghề điện tử công nghiệp của trường Cao đẳng kỹ thuật công 

nghệ Bà Rịa Vũng Tàu mô đun môn học Thiết kế và chế tạo mạch điện tử  là một  mô đun giữ 

một vị trí rất quan trọng: rèn luyện tay nghề cho học sinh. Việc dạy thực hành đòi hỏi nhiều yếu tố: 

vật tư thiết bị đầy đủ đồng thời cần một giáo trình nội bộ, mang tính khoa học và đáp ứng với yêu 

cầu thực tế. 

Nội dung của giáo trình “Thiết kế và chế tạo mạch điện tử  ” đã được xây dựng trên cơ sở 

kế thừa những nội dung giảng dạy của các trường, kết hợp với những nội dung mới nhằm đáp ứng 

yêu cầu nâng cao chất lượng đào tạo phục vụ sự nghiệp công nghiệp hóa, hiện đại hóa đất nước,.  

Giáo trình được biên soạn ngắn gọn, dễ hiểu, bổ sung nhiều kiến thức mới và biên soạn theo 

quan điểm mở, nghĩa là, đề cập những nội dung cơ bản, cốt yếu để tùy theo tính chất của các ngành 

nghề đào tạo mà giảng viên tự điều chỉnh ,bổ xung cho thích hợp và không trái với quy định của 

chương trình đào tạo trung cấp, cao đẳng . 

Tuy các tác giả đã có nhiều cố gắng khi biên soạn, nhưng giáo trình chắc chắn không tránh 

khỏi những thiếu sót, rất mong nhận được sự tham gia đóng góp ý kiến của các đồng nghiệp và các 

chuyên gia kỹ thuật đầu ngành. 

Xin trân trọng cảm ơn! 

 

                                                           Bà Rịa  ngày…...tháng….. năm 2020 

                                                            Tham gia biên soạn 

                                                   1. Chủ biên: Bùi Văn Vinh  
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Lời giới thiệu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

GIÁO TRÌNH MÔN HỌC/MÔ ĐUN 

 
Tên mô đun: Thiết kế và chế tạo mạch điện tử   

Mã mô đun:MĐ 13 

I. Vị trí, tính chất của mô đun: 

  - Vị trí của môđun : Mô đun được bố trí sau khi học sinh học xong các môn học chung như mô đun 

đo lường điện tử, mô dun kỹ thuật điện tử, an toàn điện… 

 - Tính chất của môđun : Là môn học chuyên ngành bắt buộc cho học sinh- sinh viên nghề điện tử 

công nghiệp 

II. Mục tiêu mô đun: 

     - Về kiến thức: 

+ Trình bày được phương pháp thiết kế mạch 

+ Lựa chọn được các linh kiện trong thư viện để vẽ mạch điện 

+ Trình bày được qui trình chế tạo mạch in  

   - Về kỹ năng: 

  + Thiết kế sơ đồ nguyên lý mạch điện theo các yêu cầu kỹ thuật 

+ Thiết kế sơ đồ mạch in theo sơ đồ nguyên lý 

  + Hàn và tháo được các mối hàn trong mạch điện, điện tử an toàn. 

+ Chế tạo được các mạch in đơn giản đúng thiết kế và đạt chất lượng tốt. 

+ Mô phỏng các mạch điện cơ bản  

     - Về năng lực tự chủ và trách nhiệm: 

Người học có khả năng làm việc độc lập hoặc làm nhóm, có tinh thần hợp tác, giúp đỡ lẫn 

nhau trong học tập và rèn luyện, có ý thức tự giác, tính kỷ luật cao, tinh thần trách nhiệm trong công 

việc. 

III. Nội dung mô đun: 

 



 

 

 

 

 

Bài 1: Cài đặt phần mềm trên máy tính 
 

1. Khái quát chương trình 

Môi trường vẽ và thiết kế trong Altium Designer 

a. Các vùng và khối chức năng 

 

- Editor: Là khu hiệu chỉnh. Chỉnh sửa các bản vẽ, thiết kế, câu lệnh lập trình. Ứng với 

mỗi môi trường thì có một Editor riêng 

+ Môi trường vẽ nguyên lý: Schematic Editor 

+ Môi trường vẽ mạch in : PCB Editor 

+ Môi trường vẽ thư viện nguyên lý: Schematic Lib Editor 

+ Môi trường vẽ thư viện PCB: PCB Lib Editor 



- Workspace Panels: là vùng chứa các panel chức năng, trợ giúp cho việc thiết kế như: 

Project, Libraries, Inspector ... 

- Panels Control: là nơi để bật hoặc tắt các panel. 

- Document Bar: Thanh tiêu đề của các tài liệu đang được mở 

- Menu Bar: Thanh thực đơn.  

Với mỗi môi trường khác nhau thì số lượng Menu sẽ thay đổi để phù hợp với môi 

trường đó. 

b. Các môi trường thiết kế trong Altium Designer 

Altium Designer chia làm 4 môi trường vẽ và thiết kế độc lập nhau: 

- Schematic Editor: Môi trường vẽ và thiết kế mạch nguyên lý 

 

Hình 1.5. Môi trường vẽ và thiết kế nguyên lý (Schematic Editor)  

- PCB Editor: Môi trường vẽ và thiết kế mạch in  



 

Hình 1.6. Môi trường vẽ và thiết kế mạch in (PCB Editor)  

- SCH Library Editor: Môi trường vẽ và thiết kế thư viện linh kiện nguyên lý 

 
Hình 1.4. Môi trường vẽ và thiết kế thư viện linh kiện nguyên lý (SCH Library 

Editor) 

- PCB Library Editor: Môi trường vẽ và thiết kế hình dạng và chân linh kiện 



 

Hình 1.8. Môi trường vẽ và thiết kế chân linh kiện 

 

2. Hướng dẫn cài đặt phần mềm thiết kế mạch 

Bước 1: Chạy file AltiumInstaller.exe 

 

 

 



 

Chạy Autoplay 

Hiện ra các cửa sổ cài đặt. Bạn chỉ việc next và next 

 

 

 



 

 



 
Đợi cho đến khi hoàn thành.: 

Bước 2. Crack phần mêm Altium 

 
 

Chạy file patch.exe và ấn nút patch nhưng một thông báo đc đưa ra. bạn ấn yes và tìm chọn 



đến thư mục chứa file DXP.exe mà bạn mới cài được trong ổ cứng. 

 
 

Khởi động altium lần đầu tiên bạn sẽ thấy màn hình khởi động thông báo chưa đăng ký 

 



 
Click theo hình ảnh rồi chọn đến file Altium Designer.alf trong thư mục Cr@ck Altium 

Designer 10 mà bạn vừa tải về và giải nén. 

 
Tắt Altium và khởi động lại để ý màn hình khởi động. 

 



 
Vậy là chúng ta đã cài đặt thành công altium designer 10.589 

Hướng dẫn này áp dụng cho ALtium Desginer 10. 

 



BÀI 2: VẼ SƠ ĐỒ NGUYÊN LÝ 
 

1. Tạo file thiết kế mới 

- Kích chuột vào biểu tượng DXP - Shortcut trên màn hình. 

- Kích chuột vào menu File  New  Project  PCB Project. 

 

- Tạo mới môi trường vẽ nguyên lý SCH. 

+ Cách 1: Kích chuột phải vào PCB Project vừa tạo  Add New to Project  Schematic. 



Xem hình… 



 



+ Cách 2: Kích vào Menu File  New  Schematic. Xem hình… 

 

+ Cách 3: Kích vào Menu File góc dưới màn hình  Schematic Sheet. Xem hình… 



 

- Cất file vừa tạo 

+ Tạo một Folder mới; 

+ Kích vào Menu File  Save All  

+ Đặt tên file SCH vừa tạo sau đó chương trình hỏi để đặt tên file Project vừa tạo. 

Lưu ý: tìm đường dẫn đến Folder vừa tạo để lưu 2 file này vào đó 



 

Thiết lập trang vẽ. 

Chọn khổ giấy. 

- Nhấn chuột phải vào màn hình vẽ OptionsDocument Options 

- Nhấn phím tắt O-D 

 

Hình 2.2. Các thuộc tính khổ giấy của trang vẽ nguyên lý (Schematic Sheet) 

 

- Kích chuột vào Standard Style để chọn khổ giấy. 

- Kích chuột vào Orientation để chọn chiều khổ giấy. 

+ Landscape:  Nằm ngàng 

1 2 



+ Portrait:  Thẳng đứng 

Chọn tham số cho lưới của màn hình vẽ 

- Kích chuột vào Sheet Options 

 

Hình 2.2. Các thuộc tính lưới của trang vẽ nguyên lý (Schematic Sheet) 

Snap Grids: Cho phép sự bắt dính của chỏ chuột vào lưới (2.54mm bước nhẩy của con 

chuột) 

 

 

Visible Grids: Cho phép hiển thị lưới trên bản vẽ nguyên lý (2.54mm) 



 

 

Electrical Grid: Cho phép phạm vi tối thiểu chuột bắt dính chân linh kiện (2mm) 

 

Chọn mầu nền cho bản vẽ. 

- Kích chuột vào Sheet Options  Sheet Color  chọn bất kỳ một mầu nào đó trong 

tổng số 239 mầu  ok. 

 

Hình 2.2. Các thuộc tính chọn mầu nền của trang vẽ nguyên lý (Schematic Sheet) 



Chọn đơn vị đo khoảng cáchMetric Unit System 

 

Hình 2.2. Các thuộc tính chọn đơn vị của trang vẽ nguyên lý (Schematic Sheet) 

2. Vẽ sơ đồ nguyên lý 

a. Lấy linh kiện trong thư viện: 

- Cách 1: Kích chuột trái vào biểu tượng thư viện Libraris bên trái màn hình vào thư 

viện Devices hoặc Connector kích chuột vào của sổ tìm kiếm gõ tên linh kiện bằng 

tiếng anhPlace hoặc kích đúp vào linh kiện  linh kiện cần lấy ra từ thư viện sẽ 

xuất hiện trên màn hình. 

- Cách 2: Vào thư viện Libraris Vào thư viện Devices hoặc Connector 

Component name chọn linh kiện cần lấyPlace hoặc kích đúp vào linh kiện  

linh kiện cần lấy ra từ thư viện sẽ xuất hiện trên màn hình. 

- Cách 3: Sử dụng phím tắt D-B sau đó làm tương tự như 2 bước trên. 



 

Hình. Panel Libraries 

b. Xắp xếp và đi dây cho mạch nguyên lý 

Điều các thông tin và điều chỉnh thông số linh kiện 

1 

2 

3 

4 

5 

6 



- Sau khi linh kiện cần lấy xuất hiện trên màn hình, nếu di chuột linh kiện chạy theo thì 

lúc này ta nhấn phím Tab, một của sổ lệnh hiện ra cho phép ta khai báo tham số linh 

kiện. 

 

Hình 2.2. Các thuộc tính chọn tham số linh kiện của trang vẽ nguyên lý 

(Schematic Sheet) 

+ Vùng 1: Đánh số thứ tự linh kiện. 

+ Vùng 2: Cho phép hiển thị thứ tự linh kiện hay không. 

+ Vùng 3: Cho phép hiển thị phần chú giải linh kiện. hiển thị vùng này sẽ cho phép 

hiển thị sang phần mạch in. 

+ Vùng 4: Hiển thị giá trị linh kiện. 

+ Vùng 5: Cho phép đánh giá trị linh kiện. 

+ Vùng 6: Cho phép chọn chuẩn chân linh kiện được tạo ra từ thư viện PCB. 

- Xoay linh kiện 

+ Nhấn Shift + phím cách 

+ Đảo linh kiện nhấn X hoặc Y 

1 2 

3 

5 

6 

4 



- Nhân bản linh kiện 

+ Cách 1: 

+ Chọn vào linh kiện, sử dụng tổ hợp phím Ctrl C (Copy) và Crtl V (Paste); 

+ Nháy kép vào linh kiện để thay đổi thông số tại trường Comment và Value. 

+ Cách 2: 

+ Chọn vào linh kiện, nhấn giữ phím Shift và kéo điện trở; 

+ Nháy kép vào linh kiện để  thay đổi thông số tại trường Comment và Value. 

+ Cách 3: 

+ Chọn vào linh kiện, nhấn tổ hợp phím Ctrl R, sau đó di chuyển điện trở  ra vùng 

mong muốn; 

+ Nháy kép vào linh kiện để thay đổi thông số tại trường Comment và Value. 

c. Xắp xếp:  

- Cách 1: Vào biểu tượng trên thanh công cụ 

+ Đánh dấu các đối tượng cần căn chỉnh 

+ Vào biểu tượng trên màn hình chọn cách thức sắp xếp. 

 

- Cách 2: Nhấn phím tắt Shift + Ctrl + R (L, T, B) 

- Cách 3: Vào EditAlign 

d. Đi dây cho bản vẽ nguyên lý 

❖ Dây nối Wire 

- Cách 1: Nhấp chuột vào biểu tượng trên thanh công cụ 



 

Thanh công cụ Wiring 

- Cách 2: Nhấn phím tắt P + W 

- Cách 3: Vào của sổ PlaceWire 

 

Công cụ Wire trong menu Place 

➢ Kích chuột trái 1 lần để cố định điểm bắt đầu của đường 

➢ Kéo và kích chuột trái các lần khác đề vẽ cố định các điểm bẻ góc của đường. Nhấn 

phím xóa lùi (Backspace) để hủy lần lượt các điểm bẻ góc nếu muốn 

➢ Nhấn phím Shift và phím cách (Spacebar) để thay đổi qua lại giữa các chế độ vẽ góc: 90 

độ, 45 độ, góc bất kì, tự động nối 

➢ Nhấn chuột phải để kết thúc đường 

➢ Nhấn chuột phải một lần nữa để kết thúc lệnh vẽ 

❖ Nhãn 

❖ Đường BUS 

Các đường dây tín hiệu có chức năng tương tự nhau sẽ được nhóm với nhau thành một 

đường Bus để tiết kiệm không gian vẽ 

Đường Bus có các đặc tính giống như đường Wire, nhưng sẽ có thêm một số các Bus Entry 

kết nối với Bus 

Để vẽ đường Bus: 

➢ Chọn công cụ Place Bus  hoặc Place > Bus (P B) 

➢ Vẽ đường Bus giống như đường Wire 

e. Các công cụ hỗ trợ 



Đánh số hiệu tự động cho các linh kiện 

- Bước 1: Vào menu Tools > Annotate Schematic ( Phím tắt là T A) 

 

Công cụ đặt số tự động trong menu Tools 

- Bước 2:  Điều chỉnh các thông số  trong bảng thuộc tính đặt số  hiệu tự  động (Annotate) 

 

 



+ Vùng 1: Hướng đặt tên. Có 4 hướng như sau: 

 

 

+ Vùng 2: Vùng thể hiện các số hiệu linh kiện trước khi đặt tự động 

+ Vùng 3: Vùng thể hiện các số hiệu linh kiện sau khi đặt tự động 

+ Vùng 4: Cập nhật số liệu cho vùng 3 

+ Vùng 5: Thiết lập lại (Reset) tất cả các số hiệu của linh kiện về dấu ? 

+ Vùng 6: Đưa số hiệu của linh kiện trở về số hiệu của các bước trước đó. 

+ Vùng 7: Accept Changes (Create ECO) sẽ thực thi đặt số hiệu tự động  

- Bước 3: Thực hiện các bước từ 1 đến 3 theo hình 1.52 để thay đổi số hiệu linh kiện 



f. Kiểm tra lỗi của bản vẽ nguyên lý 

- Bước 1: Vào menu Project > Compile Project ……..(phím tắt C C) 

 

Chức năng kiểm tra lỗi bản vẽ trong menu Project 

- Bước 2: Vào Workspace Panel System (hình….), chọn panel Messages 

 

Hình .  Panel  Messages trong Workspace System tại góc phải cuối vùng 

thiết kế của Altium Designer 

- Bước 3. Kiểm tra các thông báo trong panel Messages 

Nếu không có thông báo: Bản nguyên lý không có lỗi về thiết kế 

Thông báo  Warning: Bản vẽ  có một số  vấn đề, nhưng chưa thành lỗi. Nháy kép vào thông 

báo để tìm đến chỗ xảy ra vấn đề trong bản vẽ 

Ví dụ như trong hình …:  



 

Hình …. Cảnh báo đối tượng nguồn GND bị  trôi nổi 

Máy báo là  GND Power Port  bị  “thả  nổi”, không kết nối vào linh kiện.  Việc của ta là kết 

nối lại GND Power Port vào chân của Led D1. 

g. Các chức năng và công cụ hỗ trợ 

Công cụ phóng to, thu nhỏ (Zoom) 

❖ Phóng to: thực hiện theo một trong các cách sau: 

Cách 1: Nhấn giữ phím Ctrl, đẩy núm cuộn chuột lên trên. 

Cách 2: Nhấn giữ phím Ctrl, giữ chuột phải, đẩy chuột lên trên. 

Cách 3: Đưa trỏ chuột về vùng muốn phóng to, nhấn phím Page Up trên bàn phím. 

❖ Thu nhỏ: thực hiện theo một trong các cách sau: 

Cách 1: Nhấn giữ phím Ctrl, đẩy núm cuộn chuột xuống dưới 

Cách 2: Nhấn giữ phím Ctrl, giữ chuột phải, đẩy chuột xuống dưới 

Cách 3: Đưa trỏ chuột về vùng muốn phóng to, nhấn phím Page Down trên bàn phím. 

Công cụ xem bản vẽ 

❖ Xem toàn bộ bản vẽ: nhấn tổ hợp phím V D 

❖ Xem vùng chứa toàn bộ các đối tượng: nhấn tổ hợp phím Z A hoặc V F 

Công cụ cầm nắm, di chuyển bản vẽ 

❖ Cầm bản vẽ: Nhấn giữ chuột phải và di chuột, kéo bản vẽ đến vùng mong muốn trên 

màn hình 

❖ Di chuyển bản vẽ theo chiều ngang: Nhấn giữ phím Shift và cuộn chuột lên hoặc xuống 

để di chuyển bản vẽ sang trái hoặc phải 



❖ Di chuyển bản vẽ theo chiều dọc: Cuộn chuột lên xuống để di chuyển bản vẽ lên trên 

hoặc xuống dưới 

Công cụ di chuyển, xoay, lật đối tượng 

❖ Di chuyển đối tượng: Nhấn giữ chuột trái vào đối tượng và di chuyển đối tượng ra vùng 

mong muốn trong bản vẽ 

❖ Xoay đối tượng: Chọn chuột vào đối tượng và nhấn phím cách (Space Bar) để xoay đối 

tượng theo chiều ngược chiều kim đồng hồ. Nhấn giữ phím Shift và nhấn phím cách 

để xoay đối tượng theo chiều cùng chiều kim đồng hồ. 

❖ Lật đối tượng:  

 Lật theo chiều ngang (trục X): Nhấn giữ chuột trái vào đối tượng (trong trạng thái di 

chuyển đối tượng), nhấn phím X trên bàn phím 

 Lật theo chiều dọc (trục Y): Nhấn giữ chuột trái vào đối tượng (trong trạng thái di 

chuyển đối tượng), nhấn phím Y trên bàn phím 

Công cụ tìm kiếm đối tượng trên bản vẽ 

Cho phép tìm kiếm một hoặc một nhóm đối tượng nào đó trên bản vẽ theo các thông số 

mong muốn 

Các bước tìm kiếm: 

 



Hình . Bảng lựa chọn thông số để tìm kiếm một hoặc một nhóm đối tượng 

➢ Kích chuột phải trong vùng vẽ, chọn Find Similar Objects… hoặc nhấn tổ hợp phím 

Shift F 

➢ Đưa chuột đến loại đối tượng cần tìm trên bản vẽ 

➢ Lựa chọn, thay đổi các thông số cần tìm trong bảng thuộc tính 

 Zoom Matching: phóng to vùng chứa nhóm đối tượng tìm được 

 Clear Existing: xóa kết quả của phiên tìm trước 

 Mask Matching: làm mờ đi những đối tượng không nằm trong phạm vi tìm kiếm 

 Select Matching: Tự động chọn những đối tượng được tìm thấy 

 Create Expression: Tạo đoạn mã lệnh tìm kiếm trong panel SCH Filter 

 Run Inspector: Mở panel SCH Inspector sau khi tìm kiếm xong 

 Same: Các thuộc tính giống nhau của nhóm đối tượng cần tìm 

 Any: Các thuộc tính không quan tâm 

 Different: Các thuộc tính mà nhóm đối tượng phải khác nhau 

h. Các phím tắt trong môi trường vẽ và thiết kế SCH 

- D B: Vào thư viện linh kiện. 

- X: xoay linh kiện theo trục hoành (X). 

- Y: xoay linh kiện theo trục tung (Y). 

- Shift + Space: Xoay linh kiện 45 độ. 

- Space:Xoay linh kiện 90 độ. 

- TAB:  Chỉnh sửa thuộc tính linh kiện. 

- Shift + Chuột trái: Sao chép linh kiện. 

- Ctrl + Shift + L (hoặc A+L): Căn chỉnh các linh kiện thẳng hàng bên trái. 

- Ctrl + Shift + R (hoặc A+R): Căn chỉnh các linh kiện thẳng hàng bên phải. 

- Ctrl + Shift+T (hoặc A+T): Căn chỉnh các linh kiện thẳng hàng trên đỉnh. 

- Ctrl + Shift+T (hoặc A+T): Căn chỉnh các linh kiện thẳng hàng dưới chân. 

- P N : Đánh label  

NetLabel... là mặc định mà altium đưa ra. muốn thay đổi thì bạn ấn phím tab rồi thay thành 



tên tùy ý như (out1) khi bạn click sang pin thứ 2 thì nó tự động +1 như trong Orcad. 

- P W : Đi mạch điện nối các chân linh kiện. 

- P B: Thực hiện vẽ Bus. 

- P V N : Đánh dấu chân không dùng. 

- P O: Lấy  dương nguồn Vcc. 

- P T: Thêm chữ. 

- T N: Đặt tên tự động. 

- D U: Cập nhật linh kiện từ sơ nguyên lý sang mạch in. 

- T N:  Kiểm tra lỗi. 



BÀI 3: THIẾT KẾ MẠCH IN TRÊN MÁY TÍNH 

1. Tạo board thiết kế mớivà cửa sổ layout 

Bước 1:  

- Cách 1: Từ Panel Project, nhấn chuột phải vào tên project Dao dong da hai.PrjPcb 

>Chọn Add new to Project> Chọn PCB. 

 

Hình 3.1. Thêm một bản vẽ PCB vào Project từ Panel Project  

- Cách 2: Từ Panel Menu, nhấn chuột trái vào tên Project Chọn Add New to Project 

chọn PCB. 

 
Hình 3.2.Thêm một bản vẽ PCB vào Projecttừ Panel Menu 



- Cách 3: Nhấn chuột trái vào Panel Files chọn PCB file trong menu New. 

 
Hình 3.3.Thêm một bản vẽ PCB vào ProjectPanel Files 

Lưu ý: 3 cách này phải đặt lại kích thước cho bản vẽ. 

Cách đặt lại kích thước cho bản vẽ PCB như sau: 

- Ra màn hình vẽ PCB vẽ chọn lớp Top Layer chọn công cụ vẽ đường thẳng Interactive 

Routing vẽ từ gốc tọa độ một đường thẳng ngang và dọc sau đó kích vào đường 

ngang khai báo vào cửa sổ End X giá trị kích thước ngang. kích vào đường dọc khai 

báo vào cửa sổ End Y giá trị kích thước dọc. 

 



Hình 3.4 Khai báo kích thước đường thẳng 

- Copy 2 đường ngang và dọc đã khai báo và ghép lại với hai đường cũ thành hình chữ 

nhật sau đó đánh dấu 4 đường mầu đỏ chuyển thành mầu trắng. xem hình …. 

 

 
Hình 3.5 Kích thước đường bao mạch 

 

- Vào Design  Board Shape  Define…kích thước mạch in theo thiết kế xuất hiện 

trên màn hình. 

 
Hình 3.6 Xác định vùng vẽ board mạch 

Cách 4: Nhấp chuột trái vào Panel Files chọn PCB Board Wizard… Next  



 
Hình 3.7 Khai báo kích thước board mạch bằng cửa xổ lệnh 

-  Chọn đơn vị đo Metric  (máy mặc định đơn vị in Imperial) 



 
Hình 3.8 Khai báo đơn vị đo 

-  Next   
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Hình 3.9 Khai báo các tham số board mạch 

-  Next  Next  Next  Through-hole components  Next  Choose Default 

Trach and Via Sizes  Next  finish. 

 

❖ Bước 2: Trong Panel Project, nhấn chuột phải vào tên Pcb1.PcbDoc >Chọn Save ( 

hình 3.4)  > Đánh PCB vi dieu khien vào trường File name (hình 3.5).  

Chỉnh lại đường dẫn cho bản PCB được lưu cùng trong thư mục đã định. Chọn nút 

Save (hình 3.5) để lưu file PCB vào folder. 

 

 

Hình 3.10.Thủ tục chọn Save 

 



 
Hình 3.11. Lưu bản PCB vừa tạo vào folder vừa tạo  

❖  Bước 3: Nhấn chuột phải vào tên của Project, chọn Save Project để lưu lại thiết lập của 

Project 

 Lưu ý: 

Những thiết lập mới của bản vẽ hay thay đổi về kết cấu Project sẽ được hiển 

thị bằng biểu tượng tài liệu màu đỏ trong Project Panel hoặc dấu sao (*) trên 

thanh tiêu đề của bản vẽ. 

 

Hình 3.12. Biểu tượng có sự thay đổi mới (chưa lưu) 

Để đề phòng trong việc mất điện đột xuất hoặc máy gặp sự cố (treo máy, ….) ta nên 

tạo cho mình thói quen 3 đến 5 thao tác tiến hành lưu 1 lần (nhấn tổ hợp phím Ctrl 

S). 



2. Thiết kế mạch in 

Cập nhật (Update) từ bản vẽ nguyên lý sang bản vẽ mạch in 

❖ Bước 1: Từ bản vẽ nguyên lý, chọn menu Design>Update PCB Document … (phím 

tắt D U) 

 

Hình 3.13. Chưc năng Update sang PCB nằm trong menu Design. 

❖ Bước 2: Thực hiện các bước từ 1 đến 4 trong bảng thực thi hình 3.8 

 

Hình 3.14. Bảng thực hiện chuyển đổi từ nguyên lý sang PCB. 

 Vùng 1: Theo dõi sự cập nhật của linh kiện, đường dây và sẽ thông báo trên cột 

Check tại vùng 3 

 Vùng 2: Thực thi, thông báo trên cột Done tại vùng 3 

 Vùng 3: Các thông báo (lỗi, cảnh báo….) 

 Vùng 4: Đóng bảng thực thi khi hoàn thành 

 Lưu ý: 

Trong thực tế, không cần nhấn Validate Changes (vùng 1, hình 3.8), chỉ cần 

nhấn nút Execute Changes (vùng 2, hình 1.65) là phần mềm đã thực hiện 

luôn công việc của Validate Changes 

Chỉ cần quan tâm đến báo lỗi ở cột Done (vùng 3, hình 3.8) 

❖ Bước 3: Trong môi trường thiết kế PCB, nhấn tổ hợp phím Z A để nhìn thấy toàn bộ 

linh kiện vừa được cập nhật 



 

Hình 3.15. Các linh kiện được cập nhật từ bản vẽ nguyên lý  

sang bản vẽ PCB 

2.1. Sắp xếp linh kiện 

2.1.1. Một số quy tắc sắp xếp linh kiện 

 Các linh kiện nằm trong cùng một khối chức năng thì được sắp xếp gần nhau 

 Đối với các mạch thông thường, sắp xếp các linh kiện càng gần nhau thì mạch càng 

gọn đẹp 

 Đối với mạch đòi hỏi sự phối hợp trở kháng, dung kháng …hoặc phải theo chuẩn nào 

đó (card mạng, card âm thanh …) thì sắp xếp theo yêu cầu kĩ thuật của mạch đó 

 Các linh kiện có phát nhiệt (IC nguồn, các phần tử công suất) thì nên quay phần tản 

nhiệt ra mép mạch 

 Chiều của các linh kiện phải được sắp xếp theo chiều ngang hoặc dọc so với mạch, 

không nên để chéo 

2.1.2. Các công cụ hỗ trợ trong môi trường vẽ PCB 

Công cụ phóng to, thu nhỏ (Zoom) 

❖ Phóng to: thực hiện theo một trong các cách sau: 

Cách 1: Nhấn giữ phím Ctrl, đẩy núm cuộn chuột lên trên 

Cách 2: Nhấn giữ phím Ctrl, giữ chuột phải, đẩy chuột lên trên 

Cách 3: Đưa trỏ chuột về vùng muốn phóng to, nhấn phím Page Up trên bàn phím. 

❖ Thu nhỏ: thực hiện theo một trong các cách sau: 

Cách 1: Nhấn giữ phím Ctrl, đẩy núm cuộn chuột xuống dưới 

Cách 2: Nhấn giữ phím Ctrl, giữ chuột phải, đẩy chuột xuống dưới 

Cách 3: Đưa trỏ chuột về vùng muốn phóng to, nhấn phím Page Down trên bàn phím. 

Công cụ xem bản vẽ 

❖ Xem toàn bộ bản vẽ: nhấn tổ hợp phím V D 

❖ Xem vùng chứa toàn bộ các đối tượng: nhấn tổ hợp phím Z A hoặc V F 



Công cụ cầm nắm, di chuyển bản vẽ 

❖ Cầm bản vẽ: Nhấn giữ chuột phải và di chuột, kéo bản vẽ đến vùng mong muốn trên 

màn hình. Muốn cầm bản vẽ đến một vị trí xa hơn, nhấn tổ hợp Ctrl A trên bàn phím, 

chọn chuột vào một linh kiện bất kì, nhần giữ chuột trái và kéo ra vị trí mong muốn. 

❖ Di chuyển bản vẽ theo chiều ngang: Nhấn giữ phím Shift và cuộn chuột lên hoặc 

xuống để di chuyển bản vẽ sang trái hoặc phải 

❖ Di chuyển bản vẽ theo chiều dọc: Cuộn chuột lên xuống để di chuyển bản vẽ lên trên 

hoặc xuống dưới 

Công cụ di chuyển, xoay, lật đối tượng 

❖ Di chuyển đối tượng: Nhấn giữ chuột trái vào đối tượng và di chuyển đối tượng ra 

vùng mong muốn trong bản vẽ 

❖ Xoay đối tượng: Chọn chuột vào đối tượng và nhấn phím cách (Space Bar) để xoay đối 

tượng theo chiều ngược chiều kim đồng hồ. Nhấn giữ phím Shift và nhấn phím cách 

để xoay đối tượng theo chiều cùng chiều kim đồng hồ. 

❖ Lật đối tượng:  

 Lật theo chiều ngang (trục X): Nhấn giữ chuột trái vào đối tượng (trong trạng thái di 

chuyển đối tượng), nhấn phím X trên bàn phím 

 Lật theo chiều dọc (trục Y): Nhấn giữ chuột trái vào đối tượng (trong trạng thái di 

chuyển đối tượng), nhấn phím Y trên bàn phím 

 Lưu ý: 

Không nên lật linh kiện trong bản vẽ PCB, vì có thể sẽ làm sai thiết kế ban 

đầu của mạch 

❖ Chuyển lớp cho đối tượng: Nhấn giữ chuột trái vào đối tượng >  nhấn phím L trên bàn 

phím, đối tượng sẽ được chuyển qua lại giữa lớp trên (Top layer) và lớp dưới (Bottom 

Layer) 

 Lưu ý: 

Cần thận trọng trong việc chuyển lớp cho linh kiện. Vì linh kiện đang trong 

trạng thái cắm hoặc dán ở lớp trên sẽ chuyển thành cắm hoặc dán ở lớp dưới. 

Điều này sẽ gây sai lệch hoặc kênh mạch so với vỏ hộp hoặc tấm gá  

❖ Di chuyển con trỏ về tọa độ mong muốn: Nhấn tổ hợp phím J L và nhập tọa độ cần di 

chuyển con trỏ chuột tới 



 

Hình 3.16. Di chuyển con trỏ về vị trí (5mm, 10mm)  

Công cụ chuyển đổi nhanh đơn vị của bản vẽ PCB 

 Đơn vị được sử dụng trong môi trường vẽ PCB là mini Inch (mil) và mini mét (mm).  

100 mil = 2.54 mm 

 Trong quá trình vẽ và thiết kế, chúng ta cần sử dụng qua lại giữa hai đơn vị trên. 

 Nhấn phím Q trên bàn phím để chuyển đổi nhanh giữa mil và mm. 

 Thanh trạng thái sẽ thông báo đơn vị đo nào đang được sử dụng. 

 

Hình 3.14. Thanh trạng thái hiển thị đơn vị đang được sử dụng 

Công cụ thiết lập gốc tọa độ (đặt lại gốc) 

 Để thuận tiện cho việc tính toán vị trí mạch, linh kiện, đối tượng một cách chính xác, 

Altium cung cấp công cụ thiết lập lại gốc tọa độ (Set Origin) 

 Các bước thiết lập: 

+ Bước 1: Menu Edit > Origin > Set (phím tắt E O S) 



 

Hình 3.18. Công cụ thiết lập gốc tọa độ tại menu Edit  

+ Bước 2: Di chuột đến vị trí cần đặt gốc tọa độ mới 

+ Bước 3: Nhấn chuột trái để hoàn thành bước đặt 

 

Hình 3.19. Gốc tọa độ được đặt lại tại chân linh kiện R6 

 Lưu ý: 

Ta cũng có thể thực hiện bước 1 bằng công cụ Set Origin tại thanh công cụ 

Utility  



 

Hình 3.20. Công cụ Set Origin trong thanh công cụ Utility 

Công cụ sắp xếp linh kiện 

Altium Designer cung cấp cho chúng ta các công cụ để sắp xếp linh kiện tại thanh công cụ 

Utility 

 

Hình 3.21. Các công cụ sắp xếp trong thanh công cụ Utility 

Ta cũng có thể lấy các công cụ này bằng cách nhấn phím A trên bàn phím, rồi 

chọn công cụ mong muốn 

 

Hình 3.22. Các công cụ sắp xếp linh kiện 



Ví dụ. 

 Sắp xếp linh kiện trong mạch dao động đa hài 

❖ Bước 1: Thiết lập các thuộc tính của bản vẽ 

Nhấn phím D O trên bàn phím, bảng thuộc tính của bản vẽ hiện ra như trong hình 

3.17 

 

Hình 3.23. Các lựa chọn trong bảng thuộc tính của bản vẽ PCB 

 Vùng 1: Thiết lập đơn vị của bản vẽ là mm (metric) 

 Vùng 2: Thiết lập bắt dính chuột vào lưới là 0.1 mm 

 Vùng 3: Thiết lập bắt dính linh kiện vào lưới là 0.5 mm 

 Vùng 4: Thiết lập bắt dính chuột vào đối tượng là 0.1 mm 

 Vùng 5: Thiết lập hiển thị lưới. Kiểu lưới là đường kẻ (Lines), lưới 1 là 50mil, 

lưới 2 là 100 mil 

 Lưu ý: 

Nếu không quen sử dụng lưới, ta có thể xóa lưới bằng cách nhập 0 mm vào 

trường Grid 1 và Grid 2 

❖ Bước 2: Chọn vào Zoom > nhấn phím Delete trên bàn phím để xóa Zoom bao quanh 

linh kiện (vùng màu nâu bao quanh toàn bộ linh kiện sau khi update từ nguyên lý 

sang PCB) 

 



Hình 3.24. Vùng Zoom bao quanh linh kiện 

❖ Bước 3: Sang bên bản vẽ nguyên lý, kéo chọn những linh kiện cùng khối chức năng. 

Vào menu Tools>Select PCB Components(Phím tắt T S) 

 

Hình 3.25. Lựa chọn linh kiện có cùng khối chức năng 

 

 Lưu ý: 

Linh kiện được chọn sẽ có 4 ô vuông màu (xanh lục, xanh nhạt, đỏ) bao 

quanh thân linh kiện 

Linh kiện chưa được chọn sẽ có 4 ô vuông không màu bao quanh  

 

Hình 3.26. Phân biệt giữa linh kiện được chọn và chưa được chọn 



trong bản vẽ nguyên lý 

Lúc này, phần mềm sẽ tự chuyển sang bản vẽ PCB và cách linh kiện được chọn bên bản vẽ 

nguyên lý cũng sẽ được chọn các linh kiện bên PCB 

 

Hình 3.24. Các linh kiện được tự động chọn giống như bên nguyên lý  

❖ Bước 4: Chọn công cụ Arrange Components Inside Area trong thanh công cụ Utility 

 

Hình 3.28. Công cụ sắp xếp linh kiện trong vùng 

Nhấn giữ chuột trái, kéo chọn một vùng trong vùng làm việc (màu đen) để đưa những linh 

kiện được chọn vào vùng làm việc 

❖ Bước 5: Thực hiện lại các bước từ 1 đến 4 để đưa toàn bộ linh kiện theo từng nhóm 

chức năng vào vùng làm việc (màu đen) 



 

Hình 3.29. Các linh kiện được sắp xếp theo khối chức năng 

Bước 6:  

 Tiến hành sắp sếp các linh kiện trong cùng một khối chức năng 

 Ghép các khối chức năng với nhau 

 Điều chỉnh lại một số linh kiện cho phù hợp với không gian mạch 

 

Hình 3.30. Linh kiện được sắp xếp hoàn thiện 

 Lưu ý: 



Khi chọn vào vị trí có nhiều đối tượng đè lên nhau, sẽ có một bảng thông báo 

hiện lên, cho phép ta chọn đúng đối tượng mong muốn. 

 

 

Hình 3.31. Cho phép lựa chọn đối tượng Text hay linh kiện C1 khi 

tại vị trí chọn, có 2 đối tượng lồng lên nhau 

Khi di chuyện các thành phần của một linh kiện, thì toàn bộ linh kiện đó sẽ 

sáng lên, và các linh kiện khác thì tối đi 

 

Hình 3.32. Transistor Q2 sáng lên và các linh kiện khác tối đi khi di 

chuyển chữ Q2 

 

3. Đặt luật chạy mạch (Rule) 

Luật (Rule) quy định toàn bộ các thông số như: 

+ Độ rộng đường mạch,  

+ Khoảng cách giữa các đường mạch 

+ Khoảng cách giữa các linh kiện 

+ Khoảng bẻ góc đường mạch 

+ Độ rộng, vị trí đặt lỗ Via 

+ Lớp chạy đường mạch 

+ Độ ưu tiên của đường mạch 

Các vấn đề trong việc sắp xếp, đi dây đường mạch nằm ngoài khoảng quy định của luật 

tương ứng sẽ được máy báo lỗi  

 Các chức năng, nhiệm vụ, và ý nghĩa của các luật sẽ được nói rõ trong phụ lục 03 – 



Luật trong thiết kế mạch in bằng Altium Designer 

Các bước đặt luật cho mạch 

❖ Bước 1: Chọn menu Design>Rules (Phím tắt D R) để mở bảng các thông số luật 

(hình 3.33) 

 

Hình 3.33. Bảng các thông số về luật 

 Lưu ý: 

Nhấn vào dấu cộng (+) ở bên trái các mục để vào các mục con hoặc luật 

❖ Bước 2: Đặt luật về khoảng cách giữa các đường mạch 

 Vào mục Design Rules > Electrical > Clearance > Clearance (vùng 1, hình 3.34) 

 Đặt thông số khoảng cách nhỏ nhất giữa các đường mạch là : 0.6mm (vùng 2, hình 

3.34) 

 Nhấn Apply để hoàn thành 



 

Hình 3.34. Thiết lập luật về khoảng cách đường mạch 

❖ Bước 3: Đặt luật về độ rộng của đường mạch 

 Vào mục Design Rules > Routing > Width > Width (vùng 1, hình 3.35) 

 Đánh vào trường Name (vùng 2, hình 3.35): Duong nguon 

 Chọn bề rộng của đường nguồn (vùng 3, hình 3.35) 

+ Bề rộng nhỏ nhất (Min Width): 1 mm 

+ Bề rộng tham chiếu ( Preferrend Width): 1 mm 

+ Bề rộng lớn nhất (Max Width): 1 mm 

 Nhấn vào nút Query Builder….(vùng 4, hình 3.35) 



 

Hình 3.35. Thiết lập độ rộng của đường cấp nguồn 

 Thiết lập các thông số như (hình 3.30) 

 

Hình 3.30. Sử dụng Query Builder trong xác định điều kiện áp dụng luật cho 

đường nguồn 



+ Nhấn chuột vào vùng 1, chọn Belong To Net 

+ Nhấn chuột vào vùng 2, chọn +5V 

+ Nhấn chuột vào vùng 3, chọn Belong To Net 

+ Nhấn chuột vào vùng 4, chọn GND 

+ Nhấn chuột vào vùng 5, chọn điều kiện OR 

+ Các thiết lập sẽ được xem trước ở vùng 6 

+ Nhấn OK để hoàn thành 

 Kiểm tra lại bảng thông số cuối cùng của đường nguồn (như hình 3.31) 

 

Hình3.31. Bảng thông số luật của đường nguồn  

 Nhấn chuột phải vào mục Width, chọn New Rule… để thêm luật cho các đường 

mạch khác (hình 3.32) 



 

Hình 3.32. Thêm một luật cho độ rộng đường mạch 

 Chọn các thông số cho các đường mạch còn lại (không phải đường nguồn) như hình 

3.33 

 

Hình 3.33. Thông số về độ rộng của các đường tín hiệu 

+ Trường Name (vùng 2): Tin hieu 

+ Chữ Width mới được tạo ở vùng 1sẽ trở thành Tin hieu 

+ Vùng 3 Chọn Min: 0.5 mm, Pref: 0.8 mm, Max: 1 mm 

+ Nhấn Apply để hoàn thành 

❖ Bước 4: Thiết lập cấu trúc chạy đường mạch (có tác dụng trong đi mạch tự động  - 

Auto route) 

 Chọn Routing Topology > Routing ToPology 



 Trong trường Topology, chọn Shortest (ngắn nhất) 

 Nhấn Apply để hoàn thành 

 

Hình 3.34. Thiết lập cấu trúc chạy đường mạch 

❖ Bước 5: Thiết lập quyền ưu tiên chạy đường mạch 

 Vào mục Routing Priority > Routing Priority (vùng 1, hình 3.34) 

 Đánh vào trường Name (vùng 2, hình 3.34): Uu tien nguon 

 Trường Routing Priority (vùng 2, hình 3.34) chọn 1 

 Nhấn vào nút Query Builder….(vùng 4, hình 3.34) 

 

 

Hình 3.35. Thiết lập chế độ ưu tiên chạy mạch cho đường nguồn 

 Thiết lập các thông số như (hình 3.35) 



 

Hình 3.36. Sử dụng Query Builder trong xác định điều kiện áp dụng luật cho 

đường nguồn 

+ Nhấn chuột vào vùng 1, chọn Belong To Net 

+ Nhấn chuột vào vùng 2, chọn +5V 

+ Nhấn chuột vào vùng 3, chọn Belong To Net 

+ Nhấn chuột vào vùng 4, chọn GND 

+ Nhấn chuột vào vùng 5, chọn điều kiện OR 

+ Các thiết lập sẽ được xem trước ở vùng 6 

+ Nhấn OK để hoàn thành 

 Kiểm tra lại bảng thông số cuối cùng về chế độ ưu tiên của đường nguồn (như hình 

1.94) 



 

Hình3.34. Bảng thông số luật ưu tiên của đường nguồn  

 Nhấn chuột phải vào mục Routing Priority, chọn New Rule… để thêm luật cho 

các đường mạch khác (hình 1.95) 

 

Hình 3.38. Thêm một luật cho độ ưu tiên đường mạch 

 Chọn các thông số cho các đường mạch còn lại (không phải đường nguồn) như hình 

1.96 



 

Hình 3.39. Thông số về độ ưu tiên của các đường tín hiệu 

+ Trường Name (vùng 2): uu tien tin hieu 

+ Chữ Routing Priority mới được tạo ở vùng 1sẽ trở thành uu tien tin hieu 

+ Vùng 3 Chọn Routing Priority: 2 

+ Nhấn Apply để hoàn thành. 

 

❖ Bước 6: Thiết lập lớp chạy đường mạch 

 Vào mục Routing Layer > Routing Layer (vùng 1, hình 1.97) 

 Trong trường Enabled Layer, tích chọn Bottom Layer, bỏ chọn Top Layer trong 

cột Allow Routing (Vùng 2, hình 1.97) 

Như vậy là trong bài này, ta chỉ cho đường mạch chạy ở lớp dưới (Bottom Layer) 

 Nhấn Apply để hoàn thành 



 

Hình 3.40. Thiết lập lớp chạy đường mạch 

❖ Bước 7: Thiết lập kích thước lỗ Via 

 Vào mục Routing Via Style > Routingvias (vùng 1, hình 1.98) 

 Trong trường Via Diameter (đường kính Via) (vùng 2, hình 1.98):  

Min  =  Max = Pref = 1.5 mm 

 Trong trường Via Hole Size (kích thước lỗ Via) (vùng 3, hình 1.98):  

Min  =  Max = Pref = 0.8 mm 

 Nhấn Apply để hoàn thành 

 

Hình 3.41. Thiết lập kích thước lỗ Via 



❖ Bước 8: Thiết lập độ rộng của đường kết nối giữa lớp phủ đồng đến chân linh kiện có 

cùng Net 

 Vào mục Design Rules > Plane > Polygon Connect Style > Polygon Connect 

(vùng 1, hình 1.99) 

 Vùng 2: Kiểu kết nối: Relief Connect 

 Vùng 3: Số mối nối: 4 

 Vùng 4: Góc nối: 90 độ 

 Vùng 5: Bề rộng : 0.5 mm 

 Nhấn Apply để hoàn thành 

 

Hình 3.42. Thiết lập đường kết nối với lớp phủ đồng 

❖ Bước 9: Thiết lập các điều kiện về quá trình sản xuất 

 Vào mục Design Rules > manufacturing (vùng 1, hình 1.100) 

 Tích chọn vào NetAntennae ở cột Enabled, còn tất cả những luật khác đều bỏ chọn 

(vùng 2, hình 1.100) 



 Nhấn Apply để hoàn thành 

 

Hình 3.43. Không cho phép một số luật ở Manufacturing được thực thi  

 Lưu ý: 

Nếu muốn cấm một luật nào đó không thực thi, ta chỉ cần chọn vào thư mục 

mẹ của luật đó và bỏ dấu tích tại cột Enabled 

 

❖ Bước 10: Thiết lập về khoảng cách sắp xếp linh kiện 

 Vào mục Design Rules > Placement > Component Clearance > 

ComponentClearance (vùng 1, hình 1.101) 

 Vùng 2: Chọn Specified 

 Vùng 3: Khoảng cách nhỏ nhất theo chiều ngang: 0.2 mm 

 Vùng 4: Khoảng cách nhỏ nhất theo chiều dọc:     0.2 mm 

 Nhấn Apply để hoàn thành 

 



 

Hình 3.44. Thiết lập về khoảng cách giữa các linh kiện 

❖ Bước 11: Kiểm tra lại bảng tổng hợp luật  

 

Hình 3.45. Bảng tổng hợp luật của thiết kế 

❖ Bước 12: Nhấn OK để hoàn thành bước đặt luật 

 

 



4.  Đi đường mạch 

4.1. Đi đường mạch tự động 

❖ Bước 1: Chọn menu Auto Route > All…(Phím tắt Alt A A) 

 

Hình 3.46. Chức năng đi đường mạch tự động  

❖ Bước 2: Kiểm tra, chỉnh sửa và chạy mạch 

 

Hình 3.44. Bảng thông báo trạng thái và chế độ đi đường mạch tự động  



 Vùng 1: Thông báo có xung đột gì về luật hay không. Nếu màu xanh thì luật được 

đặt là đúng, không có xung đột gì 

 Vùng 2: Điều chỉnh hướng đi đường mạch 

 Vùng 3: Sửa lại luật nếu có thông báo xung đột từ vùng 1 

 Vùng 4: Các chế độ chạy tự động mặc định 

 Vùng 5: Tiến hành chạy tự động nếu tất cả các điều kiện đều thỏa mãn 

❖ Bước 3: Chờ mạch chạy hoàn thiện, theo dõi thông báo trên panel Messages 

 

Hình 3.48. Thông báo trạng thái đi mạch tự động trong panel Messages  

 Routing finished : Đã đi dây xong 

 0 Contentions: Số đoạn có đường đè lên nhau (chập mạch) : 0 

 Failed to complete 0 connections: Số đường không được đi mạch (đứt mạch): 0 

❖ Bước 4: Chọn chuột vào đường mạch, chỉnh lại đường mạch cho đẹp 



 

Hình 3.49. Mạch in (PCB) của mạch dao động da hài bằng phương pháp đi đường 

mạch tự động 

4.2. Đi đường mạch thủ công 

❖ Bước 1: Chọn lớp Bottom Layer 

 Cách 1: Chọn vào thẻ Bottom Layer trong thanh công cụ Manage Layer Sets 

 

Hình 3.50. Chọn lớp Bottom Layer trong thanh công cụ Layer Manager 

 Cách 2: Nhấn tổ hợp phím Ctrl Shift và cuộn chuột 

 Cách 3: Nhấn phím dấu sao (*) bên bàn phím số 

❖ Bước 2: Làm tối đi các lớp không cần thiết, tránh rối mắt trong quá trình đi đường 

mạch 

Nhấn vào biều tượng DXP > Preferences …(phím tắt T P) 

 

Hình 3.51. Vào chức năng thiết lập hệ thống 



 Vào PCB Editor > Board Insight Display 

 Tích chọn vào 3 lựa chọn như vùng 3 hình 1.108 

 Nhấn OK để hoàn thành 

 

Hình 3.52. Điều chỉnh thông số trong Board Insight Display 

 Trong môi trường vẽ mạch in (PCB), ta nhấn Shift S để làm tối các lớp không cần 

thiết. 

Có thể nhấn Shift S nhiều lần để làm tối như mong muốn. 

 Có 4 mức tối: 

+ Mức 1: Không tối 

+ Mức 2: Tối xám 

+ Mức 3: Tối đen 

+ Mức 4: Tối hoàn toàn 

❖ Bước 3: Gọi chức năng đi đường mạch thủ công 

 Cách 1: Vào menu Place > Interactive Routing (phím tắt P T) 

 

Hình 3.53. Chức năng đi mạch thủ công trong menu Place 

 Cách 2: Chọn vào biểu tượng Interactively Route Connections trên thanh công 

cụ Writing 



 

Hình 3.55. Chức năng đi mạch tự động trên thanh công cụ Writing 

❖ Bước 4: Đưa chuột vào chân linh kiện và bắt đầu đi đường mạch theo các đường nối 

có sẵn (đường có màu trắng, mảnh)  

 

Hình 3.56. Đi đường mạch theo các đường nối có sẵn  

 Lưu ý: 

Khi một đường mạch đang được nối, thì nó sẽ sáng lên. 

Khi muốn kiểm tra một mối nối nào đó, ta giữ Ctrl và nhấn chuột trái, mối 

nối đó cũng sẽ được sáng lên 

Muốn tất cả các đường cùng sáng trở lại, ta nhấn phím Shift C hoặc nút 

Clear tại góc cuối bên phải màn hình làm việc 

Nháy kép chuột trái để chốt một đường mạch tại một vị trí nào đó  

Muốn hủy một lệnh vẽ đang được thực thi, ta nhấn chuột phải hoặc phím 

ESC trên bàn phím  

Mạch sau khi đi dây thủ công: 

 



 

Hình 3.54. Đi mạch theo phương pháp thủ công  

5.Luyện tập 

Vẽ mạch khuếch đại Emiter chung dùng transistor theo kiểu cầu phân áp 

 

Hình 3.58. Sơ đồ nguyên lý của mạch khuếch đại EC 

Gợi ý: Bảng thông số của linh kiện được cho ở bảng 1.3 dưới đây 

T

T 

Chủng 

loại 
Thư viện 

Tên 

trong 

thư 

viện 

Số 

hiệ

u 

Số 

lượ

ng 

Comment Value 
Ghi 

chú 

1 Điện trở 
Miscellaneou

s Devices 
Res1 R? 4 

100K, 1K, 

270K, 

2K2 

100K, 

1K, 

270K, 

2K2 

Trở 

thường 

2 
Transist

or NPN 

Miscellaneou

s Devices 
NPN Q? 2 C1815 2SC1815 

Đổi lại 

thứ tự 

chân 

3 Tụ điện Miscellaneou Cap C? 3 10uF/16V 10uF/16V Tụ hóa 



s Devices Pol1 

4 Cọc đấu 
Miscellaneou

s Connectors 

Heade

r2 
P? 2 

5A Blue 

Header 2 
IN, OUT 

Cọc đấu 

nguồn 

kiểu 

vặn dây 

 

 



Bài 4: MÔ PHỎNG MẠCH ĐIỆN 

Giới thiệu: 

- Trong cơ khí, kỹ thuật hàn đóng vai trò cực kỳ quan trọng, giúp đánh giá được chất 

lượng đào tạo nguồn nhân lực. Trong ngành điện tử việc thành thạo các kỹ năng hàn linh kiện 

điện tử cũng như việc trang bị kiến thức tương đối hoàn thiện về linh kiện điện tử sẽ giúp cho 

sinh viên khỏi bỡ ngỡ khi ra truong đi làm. 

Mục tiêu: Sau khi học xong bài này người học có khả năng: 

- Phân tích được các bước mô phỏng mạch điện tử trên máy tính. 

- Vẽ được sơ đồ mạch điện đúng thông số và yêu cầu kỹ thuật 

- Mô phỏng mạch điện bằng phần mềm 

- Phân tích được dạng sóng điện áp, dòng điện vào và ra 

Nội dung :  

4.1Quy trình vẽ và thiết kế 

4.1.1 Tạo mới Project 

❖ Bước 1: Tại ổ D:\ của máy tính, nhấn chuột phải, chọn New > Folder để tạo mới 

một thư mục, 

Đặt tên thư mục là: Dao dong da hai 

❖ Bước 2: Khởi chạy chương trình Altium Designer Winter 09 

❖ Bước 3: Tạo một Project PCB 

Hình 4.2. Tạo mới một dự án mạch in (PCB Project) 



Lưu ý: 

Nên lưu tất cả những gì có liên quan đến việc thiết kế một mạch nào đó 

trong cùng một thư mục để tiện cho công việc tìm kiếm và quản lý 

❖ Bước 4: Vào menu File > Save Project để lưu Project với: 

✓ Tên: Dao dong.PrjPCB 

✓ Dường dẫn: D:\Dao dong da hai\ 
 

 

Hình 4.3. Vị trí lưu trữ và tên của Project 
 

 

4.12.Tạo mới một bản vẽ nguyên lý 

Tạo một bản vẽ nguyên lý và thêm vào Project theo các bước sau 

❖ Bước 1: Từ panel Project, bấm chuột phải, chọn Add new to project > 

Shematic 

Hình 4.4. Tạo mới một bản vẽ nguyên lý (SCH Doc) 



 

Lưu ý: 

Panel Projects mặc định nằm bên trái vùng thiết kế 

 

 

 

 

 

 

 

 

 

 

 
Hình 4.5. Panel Project 

 

Ta có thể gắn panel cố định bằng các nhấn vào biểu tượng đinh ghim tại 

thanh tiêu đề của Panel hoặc để cho Panel thụt vào để tiết kiệm không gian vẽ 

Nếu Panel Projects chưa xuất hiện (hoặc bị tắt) ta làm theo 1 trong 2 cách 

sau:  
✓ Cách 1: Vào menu View > Workpace Panels > System > Projects 

(phím tắt V W S P) 

 

 

 

 

 

 

 

 

 

 

 

 
Hình 4.6. Làm hiện Panel Project từ menu View 



 

Lưu ý: 

✓ Cách 2: Nhấn chuột vào vùng Workpace System > Chọn Projects 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 4.7. Làm hiện panel Project từ vùng Workspace Panel 

 

Nếu Panel sau khi được lấy ra dưới dạng trôi nổi (floating), ta chọn chuột 

vào phần tiêu đề của Panel, kéo chuột, đưa Panel vào các ô đại điện cho các vị 

trí tương ứng 

 

 

 

 

 

 

 

 

 

 

 

 

 
Hình 4.8. Các vị trí có thể đặt panel Project 



❖ Bước 2: Lưu bản vẽ vào ổ cứng 

➢ Nhấn chuột phải vào tên của bản thiết kế nguyên lý trong Projects Panel, 

➢ Chọn Save để lưu. 

➢ Lưu bản vẽ trong cùng thư mục Dao dong da hai 

➢ Đặt tên cho bản vẽ và định dạng của bản vẽ nguyên lý 

➢ Nhấn Save để hoàn thiện bước lưu 

Hình 4.9. Các bước đặt tên và lưu bản vẽ nguyên lý 

 

 
❖ Bước 3: Thiết lập bản vẽ 

Nhấn tổ hợp phím D O để vào Document Options, thiết lập như trong Hình 

4.10 

Hình 4.10. Bảng hội thoại thiết lập bản vẽ 



4.1.3.Lấy linh kiện từ thư viện ra bản vẽ 

Ta thấy như trong sơ đồ nguyên lý trên, mạch dao động đa hài sử dụng: 
 

TT Loại linh kiện Giá trị Loại Số lượng 

1 Điện trở 100K Ω Trở thường 2 

2 Điện trở 1K Ω Trở thường 2 

3 Điện trở 220 Ω Trở thường 2 

4 Transistor 2SC2383 NPN 2 

5 Tụ điện 1uF/16V Tụ hóa 2 

6 Led đơn Blue Phi 5 2 

7 Cọc đầu nguồn 2 Chân Header 2 1 

Bảng 4.1. Bảng danh sách linh kiện trong mạch 

 
42.3.1 Lấy điện trở 

❖ Bước 1: Trong panel Libraries, chọn thư viện Miscellaneous Devices.IntLib 

(vùng 1, Hình 4.11) 

❖ Bước 2: Đánh tên điện trở là *res ở vùng 2 để lọc ra chủng loại linh kiện là 

điện trở 

❖ Bước 3: Nhấn giữ và kéo điện trở Res1 ra vùng thiết kế. 

 

Hình 4.11. Tìm kiếm và lấy điện trở tại panel Libraries 



Trong quá trình kéo điện trở ra vùng thiết kế, nhấn phím TAB để vào cửa sổ 

điều chỉnh thông số của điện trở. 

Chỉnh thông số của điện trở 100K như sau: 
 

 

Hình 4.12. Điều chỉnh các thông số của điện trở trong cửa sổ Compornent 

Properties 

 

Vùng 1: Trường Comment cho là 100K 

Vùng 2: Bỏ chọn ở lựa chọn Visible để không cho hiển thị giá trị trong trường 

Comment trên bản vẽ nguyên lý (phần này chỉ cho hiển thị ở phần bản vẽ mạch 

in) 

Vùng 3: Trường Value, đánh vào 100K, và tích vào dấu chọn Visible để hiển 

thị giá trị của điện trở trên bản vẽ nguyên lý. 

Vùng 4: Trường Footprint, cho phép lựa chọn kiểu chân của linh kiện trong 

bản vẽ PCB (hình dạng thực của linh kiện) . 

Trong ví dụ này, ta sử dụng kiểu chân mặc định của thư viện. 

Nhấn OK để hoàn thành bước điều chỉnh thông số cho điện trở vừa lấy ra. 

 

Các điện trở còn lại cũng có cùng thông số với điện trở vừa lấy ra, nên để giảm 

thiểu thời gian, ta tiến hành nhân bản (copy) các điện trở còn lại 

Để thực hiện nhân bản, ta làm theo một trong 3 cách sau: 

  Cách 1: 

− Chọn vào điện trở, sử dụng tổ hợp phím Ctrl C (Copy) và Crtl V (Paste) 



− Nháy kép vào điện trở để thay đổi thông số tại trường Comment và Value 
 

Hình 4.13. Thông số của điện trở 1K 
 

Hình 4.14. Thông số của điện trở 220R 
 

Cách 2: 

− Chọn vào điện trở, nhấn giữ phím Shift và kéo điện trở 

− Nháy kép vào điện trở để thay đổi thông số tại trường Comment và Value 

(như trong Hình 4.12 và Hình 4.13) 



Lưu ý: 

Có thể sử dụng cách này để sao chép một nhóm đối tượng (linh kiện, 

đường dây, bus ……) bằng cách nhấn chuột trái, kéo chọn bao phủ toàn bộ 

nhóm, sau đó nhấn tổ hợp phím Ctrl R, kéo nhóm đối tượng vừa được sao chép 

ra vùng mong muốn 

Cách này sẽ không làm tăng số hiệu linh kiện sau sao chép 

Lưu ý: 

Chú ý: Đơn vị Ω (Ohm) của điện trở sẽ được thay thế bằng kí tự R 

 

   Cách 3: 

− Chọn vào điện trở, nhấn tổ hợp phím Ctrl R, sau đó di chuyển điện trở ra 

vùng mong muốn 

− Nháy kép vào điện trở để thay đổi thông số tại trường Comment và Value 

(như trong Hình 4.13 và Hình 4.14) 

Cuối cùng, chúng ta được 6 điện trở như hình 1.14 

 

Hình 4.15. Các điện trở sau khi được nhân bản và điều chỉnh thông số 
 

Lưu ý: 

Có thể sử dụng cách này để sao chép một nhóm đối tượng (linh kiện, 

đường dây, bus ……) bằng cách nhấn chuột trái, kéo chọn bao phủ toàn bộ 

nhóm, sau đó nhấn giữ Shift và kéo chuột 

Cách này sẽ làm cho số hiệu linh kiện sau sao chép tăng lên một đơn vị 

Ví dụ: R1 → R2; C1 → C2 



42.3.2Lấy Transistor 

❖ Bước 1: Trong panel Libraries, chọn thư viện Miscellaneous 

Devices.IntLib (vùng 1, Hình 1.16) 

❖ Bước 2: Đánh tên transitor là *NPN ở vùng 2 để lọc ra chủng loại linh kiện 

là transistor NPN 

❖ Bước 3: Nhấn giữ và kéo transistor NPN ở vùng 3 ra vùng thiết kế. 

Hình 4.16. Tìm kiếm và lấy transitor NPN tại panel Libraries 



❖ Bước 4: Trong trạng thái đang kéo linh kiện, nhấn phím TAB để vào bảng 

thuộc tính của transistor. 

Ta cũng có thể vào bảng thuộc tính bằng cách nháy kép vào transistor 

Chỉnh các thông số như trong hình 1.16 

Hình 4.14. Bảng thuộc tính của Transistor NPN 
 

   Vùng 1: Nhập tên C2383 vào trường Comment, bỏ chọn Visible 

  Vùng 2: Nhấn vào nút Add để thêm thuộc tính cho Transitor 

   Vùng 3: Đánh tên Value vào trường Name 

   Vùng 4: Đánh tên 2SC2383 vào trường Value, tích vào lựa chọn Visible 

  Vùng 5: Nhấn OK để hoàn tất bước thêm thuộc tính. 

 

❖ Bước 5: Điều chỉnh lại thứ tự chân của transitor 

   Tìm datasheet của transistor 2SC2383 trên Internet 

Hình 4.18. Tìm kiếm tài liệu kĩ thuật (datasheet) của transistor trên google.com 



   Tải tài liệu kĩ thuật về máy tính, mở và tìm đến thông số về thứ tự chân của 

transistor 2SC2383 

Hình 4.19. Thông số về thứ tự chân của transistor 2SC2383 
 

Theo như Hình 4.19, thì thứ tự chân của qkjm lần lượt là E – C – B 

   Điều chỉnh thứ tự chân của linh kiện trong bản vẽ nguyên lý theo các bước 

trong Hình 4.20 



 

 

Hình 4.20. Điều chỉnh lại các thiết lập về chân của transistor 2SC2383 

 

+ Vùng 1: Bỏ lựa chọn khóa chân (Lock Pins) để có thể di chuyển, đổi chân, 

đặt lại tên chân linh kiện 

+ Vùng 2: Nhấn vào nút hiệu chỉnh chân. 

+ Vùng 3: Cho phép hiển thị số thứ tự chân 

+ Vùng 4: Nhấn OK để hoàn tất bước hiệu chỉnh 

Số thứ tự chân được hiển thị như sau: 

 

Hình 4.21. Hiển thị số chân của transistor 2SC2383 

 

Như trên hình, ta thấy chân của C2383 theo thứ tự là C-B-E. Điều này không 

đúng như trong datasheet của linh kiện. 

Nháy kép vào chân linh kiện để vào cửa sổ điều chỉnh các thông số của chân: 



 

 

Hình 4.22. Bảng thuộc tính của chân linh kiện 

 

+ Vùng 1: Tên của chân, như trong hình là chân Collector 

+ Vùng 2: Thứ tự của chân, như trong datasheet của transistor 2SC2383, chân 

Collector có số thứ tự là 2 

+ Vùng 3: Loại chân. Trong bài này, chân transistor là loại chân thụ động 

(passive) 

+ Vùng 4: Chiều dài của chân trong bản vẽ nguyên lý. Trong bài này, ta để 

mặc định 



Ta hiệu chỉnh lại thứ tự các chân tiếp theo của Transistor theo các bước tương tự 

như trên. 

Kết quả đạt được sau khi hiệu chỉnh xong: 

Hình 4.23. Transistor sau khi chỉnh lại thứ tự chân 

 

a) Thứ tự  chân trong thư viện b) Thứ tự chân thực tế theo datasheet 

 

So sánh với Datasheet một lần nữa 

Hình 4.24. Đối chiếu lại một lần nữa về kiểu và thứ tự chân của 2SC2383 



Nháy kép vào transistor 2SC2383 để mở bảng thuộc tính (Compornent 

Properties), chọn vào Lock Pins để khóa lại các chân linh kiện sau khi đã hiệu chỉnh 

xong 

Hình 4.25. Khóa lại chân linh kiện sau khi đã hiệu chỉnh xong 

 

❖ Bước 5: Nhân bản thêm một Transistor 2SC2383 

Cũng giống như cách nhân bản điện trở, ta làm theo một trong 3 cách sau: 

+ Sử dụng tổ hợp phím Ctrl C và Ctrl V 

+ Chọn vào linh kiện, nhấn giữ phím Shift và nhấn kéo chuột trái 

+ Chọn vào linh kiện, sử dụng tổ hợp phím Ctrl R 

Transistor 2SC2383 sau khi lấy ra: 

 

Hình 4.26. Hai transistor 2SC2383 được lấy ra 

 
423.3 Lấy tụ điện 

❖ Bước 1: Trong panel Libraries, chọn thư viện Miscellaneous 

Devices.IntLib (vùng 1, Hình 4.27) 

❖ Bước 2: Đánh tên tụ là *CAP ở vùng 2 để lọc ra chủng loại linh kiện là tụ 

phẳng 

❖ Bước 3: Nhấn giữ và kéo tụ phẳng CAP ở vùng 3 ra vùng thiết kế. 



 

 

Hình 4.24. Tìm kiếm và lấy tụ phẳng tại panel Libraries 

 

❖ Bước 4: Điều chỉnh các thông số của tụ điện 



 

 

Hình 4.28. Bảng thuộc tính của tụ điện phẳng CAP 

 

+ Vùng 1: Tụ phẳng 100nF có kí hiệu trên thân linh kiện là 104, do vậy, vùng 

Comment ta sẽ điền vào đó là 104. 

+ Bỏ chọn ở mục Visible của phần comment này để không cho hiển thị trong 

bản vẽ nguyên lý 

+ Vùng 2: Giá trị thực của tụ là 100nF 

+ Vùng 3: Cho phép chọn lại kiểu chân của linh kiện trong mạch in. Ở bài này, 

ta để mặc định kiểu chân có sẵn của thư viện 

Nhấn OK để hoàn thành bước hiệu chỉnh thông số của tụ điện 

❖ Bước 5: Nhân bản thêm một tụ điện phẳng 

Cũng giống như cách nhân bản điện trở, ta làm theo một trong 3 cách sau: 

+ Sử dụng tổ hợp phím Ctrl C và Ctrl V 

+ Chọn vào linh kiện, nhấn giữ phím Shift và nhấn kéo chuột trái 

+ Chọn vào linh kiện, sử dụng tổ hợp phím Ctrl R 

Tụ điện sau khi được lấy ra: 

 
Hình 4.29. Hai tụ điện được lấy ra 



42.3.4 Lấy Led đơn 

❖ Bước 1: Trong panel Libraries, chọn thư viện Miscellaneous 

Devices.IntLib (vùng 1, Hình 4.30) 

❖ Bước 2: Đánh tên *LED vào vùng 2 để lọc ra chủng loại linh kiện là led đơn 

❖ Bước 3: Nhấn giữ và kéo LED0 ở vùng 3 ra vùng thiết kế. 

Hình 4.30. Tìm kiếm và lấy led đơn tại panel Libraries 



❖ Bước 4: Nháy kép vào Led đơn, bảng thuộc tính hiện ra, ta tiến hành điều 

chỉnh các thuộc tính của LED 

Hình 4.31. Bảng thuộc tính của LED đơn 

 

+ Vùng 1: Đánh “D5 blue” vào trường Comment. Điều này thể hiện rằng Led 

đơn có đường kính là φ5, màu xanh (Blue). Bỏ chọn ở phần lựa chọn Visible 

+ Vùng 2: Nhấn nút add để thêm thuộc tính Value cho led 

+ Vùng 3: Đánh vào trường Name là “Value” 

+ Vùng 4: Trường value, đánh vào:”Blink Led”, có nghĩa là Led nhấp nháy. 

+ Vùng 5: Lựa chọn để hiển thị giá trị Blink led lên bản vẽ 

 
❖ Bước 5: Nhân bản thêm một led đơn 

Cũng giống như cách nhân bản điện trở, ta làm theo một trong 3 cách sau: 

+ Sử dụng tổ hợp phím Ctrl C và Ctrl V 

+ Chọn vào linh kiện, nhấn giữ phím Shift và nhấn kéo chuột trái 

+ Chọn vào linh kiện, sử dụng tổ hợp phím Ctrl R 

Led sau khi được lấy ra: 

 

Hình 4.32. Hai Led đơn được lấy ra 



4.2.3.5 Lấy cọc đâu nguồn (Header) 

❖ Bước 1: Trong panel Libraries, chọn thư viện Miscellaneous 

Connectors.IntLib (vùng 1, Hình 4.33) 

❖ Bước 2: Đánh tên *Header vào vùng 2 để lọc ra chủng loại linh kiện Header 

❖ Bước 3: Nhấn giữ và kéo Header 2 ở vùng 3 ra vùng thiết kế. 

Hình 4.33. Tìm kiếm và lấy header 2 tại panel Libraries 



❖ Bước 4: Nháy kép vào Header 2 vừa lấy ra, điều chỉnh các thuộc tính trong 

bảng thuộc tính của Header 2 

Hình 4.34. Điều chỉnh thuộc tính của Header 2 

 

+ Vùng 1: Trường Comment: Đánh vào 5A Blue Header, có nghĩa là cọc 

đấu nguồn 5A có vặn dây, màu xanh. Bỏ lựa chọn Visible để không cho 

hiển thị comment trong bản vẽ nguyên lý 

+ Vùng 2: Nhấn vào nút Add để thêm thuộc tính cho Header 2 

+ Vùng 3: Đánh vào trường Name là: Value 

+ Vùng 4: Đánh vào trường Value là: Power Supply, tức là nguồn cấp. Tích 

chọn visible để hiển thị giá trị trong bản vẽ nguyên lý 

+ Vùng 5: Nhấn OK hai lần để hoàn tất bước hiệu chỉnh 

Header 2 sau khi được lấy ra: 

 

 

 

 

 

 

Hình 4.35. Cọc nguồn (header 2) được lấy ra 



Tất cả các linh kiện sau khi đã được lấy ra và điều chỉnh thông số trong bảng 

thuộc tính (Component Properties): 

Hình 4.36. Toàn bộ linh kiện được lấy và hiệu chỉnh thuộc tính 

 

Bảng tổng kết các thông số của các linh kiện 
 

 
STT 

 
Chủng loại 

 
Thư viện 

Tên 

trong 

thư viện 

Số 

hiệu 

Số 

lượng 

 
Comment 

 
Value 

 
Ghi chú 

1 Điện trở 
Miscellaneous 

Devices 
Res1 R? 6 

100K, 1K, 

220R 

100K, 

1K, 220R 

Trở 

thường 

2 
Transitor 

NPN 

Miscellaneous 

Devices 
NPN Q? 2 C2383 2SC2383 

Đổi lại thứ 

tự chân 

3 Tụ điện 
Miscellaneous 

Devices 
Cap C? 2 104 100nF Tụ phẳng 

4 Led đơn 
Miscellaneous 

Devices 
Led1 D? 2 D5 Blue 

Blink 

Led 

Led đơn 

màu xanh 

 
 

5 

 
 

Cọc đấu 

 
Miscellaneous 

Connectors 

 
Header 

2 

 
 

P? 

 
 

1 

 
5A Blue 

Header 2 

 
Power 

Supply 

Cọc đấu 

nguồn 

kiểu vặn 

dây 

Bảng 4.2. Bảng tổng kết số liệu của các linh kiện trong mạch 



4.2.4.Sắp xếp và đi dây cho mạch nguyên lý 

        Sắp xếp linh kiện trong bản vẽ nguyên lý 

Sử dụng những công cụ trong mục 2.5 để sắp xếp linh kiện như trong Hình 4.37 

dưới đây 

Hình 4.34. Sắp xếp linh  kiện 

 

Một số lưu ý trong sắp xếp: 

   Muốn lật transitor theo như trong hình 1.36, ta chọn vào transistor cần 

lật, và nhấn phím X trên bàn phím 

   Số hiệu linh kiện, giá trị linh kiện cần sắp xếp thật gọn để tạo tính thẩm 

mĩ cho bản vẽ. 

4.2.4.1 Đi dây (Wire) cho bản vẽ nguyên lý 

❖ Bước 1: Chọn công cụ Place Wire theo một trong các cách sau: 

   Cách 1: Trên thanh công cụ Wiring Toolbar, chọm công cụ Place Wire 

Hình 4.38. Thanh công cụ Wiring 
 

   Cách 2: Nhấn tổ hợp phím P 

W   Cách 3: Chọn Menu Place 

> Wire 



Lưu ý: 

Khi vẽ, để hủy lệnh, ta nhấn chuột phải hoặc phím ESC trên bàn phím 

Các kết nối Wire đúng là kết nối có dấu X màu đỏ ở 2 đầu đường dây 

 

 

 

 

 

 

 

 

 
Hình 7.41. Dấu hiệu kết nối đường dây thành công 

 

 

Hình 4.39. Công cụ Wire trong menu Place 

 

❖ Bước 2: Kết nối các linh kiện theo mẫu: 

Hình 4.40. Đi dây kết nối các linh kiện với nhau 
 



 

 

❖ Bước 3: Kết nối đường nguồn +5V bằng Power Port 

   Chọn công cụ VCC Power Port trong Wiring Toolbar 

Hình 4.44. Đối tượng VCC Power Port trong Wiring Toolbar 

Lưu ý: 

Hai đường cắt nhau được thể hiện bằng một dấu chấm 

 

 

 

 

 

 

 

 

 

 

Hình 7.42. Dấu hiệu cắt nhau hay không cắt nhau 

 

Dấu hiệu kết nối bằng dấu chấm chỉ xuất hiện khi có sự giao nhau giữa 2 

hay nhiều đường dây với nhau. 

Nếu xuất hiện khi có 1 đường dây thì kết nối đó là sai, cần phải đi dây lại 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 7.43. Dấu chấm kết nối chỉ xuất hiện khi có sự cắt nhau của hai hay nhiều 

đường dây 



   Nhấn phím TAB để vào bảng điều chỉnh thuộc tính của VCC Power Port 

Hình 4.45. Bảng thuộc tính của VCC Power Port 

 

+ Vùng 1: Dạng của Power Port. Ở đây ta để là hình tròn (Circle) 

+ Vùng 2: Trường Net của Power Port là: +5V 

+ Vùng 3: Tích chọn vào lựa chọn Show Net Name để hiển thị tên của Power 

Port (+5V) 

Power Port sẽ có dạng như sau: 

Hình 4.46. Hình dạng và giá trị của Power Port 
 

   Ta đưa các Power Port này vào các đầu của điện trở và vào một chân của 

Header như Hình 4.47 



 

 

Hình 4.44. Kết nối Power Port +5V với mạch 

 

❖ Bước 4: Kết nối đường 0V bằng Power Port GND 

   Chọn công cụ GND Power Port trong thanh công cụ Wiring Toolbar 

Hình 4.48. Đối tượng GND Power Port trong Wiring Toolbar 
 

   Nhấn phím TAB để vào bảng điều chỉnh thuộc tính của GND Power Port 

Hình 4.49. Bảng thuộc tính của GND Power Port 



Lưu ý: 

Net Label là một phương thức kết nối các đường dây mà thông qua việc đặt 

tên cho các đường dây đó. Điều này sẽ làm giảm thiểu các đường dây được vẽ trên 

bản vẽ nguyên lý. 

Một mối nối sẽ được tạo ra giữa tất cả các đường dây có tên Net Label giống 

nhau trong một bản vẽ. Trong một số trường hợp, tất cả các đường dây có tên Net 

Label giống nhau ở các Sheet trong cùng một Project sẽ được kết nối với nhau. 

VCC Power Port và GND Power Port là hai trường hợp đặc biệt của Net 

Label. Như trong hình 7.50, chân 1 của Header 2 sẽ được nối với tất cả các chân 

linh kiện có cùng GND Power Port 

+ Vùng 1: Chọn dạng của GND Power Port là: Power Ground 

+ Vùng 2: Để tên GND như mặc định 

+ Vùng 3: Bỏ chọn tại lựa chọn Show Net Name của GND Power Port 

 

    Đưa các GND Power Port vào các vị trí như Hình 4.50 

Hình 4.50. Kết nối GND Power Port với mạch 
 

 

4.2.3 Đặt số hiệu tự động cho các linh kiện trong bản vẽ 

❖ Bước 1: Vào menu Tools > Annotate Schematic ( Phím tắt là T A) 



 

 

Hình 4.51. Công cụ đặt số hiệu tự động trong menu Tools 

 

❖ Bước 2: Điều chỉnh các thông số trong bảng thuộc tính đặt số hiệu tự động 

(Annotate) 

Hình 4.52. Bảng thuộc tính của công cụ đặt số hiệu tự động Annotate 
 

   Vùng 1: Hướng đặt tên. Có 4 hướng như sau: 



Lưu ý: 

Các hướng này chỉ có tác dụng với các linh kiện cùng loại 

Ví dụ: Điện trở R sẽ có số hiệu từ R1 

Tụ điện C sẽ có số hiệu từ C1 

Không nên hiểu là sắp xếp theo hình thức đếm dần linh kiện: R1, C2, Q3 …. 

 

 
 

Hình 4.53. Các lựa chọn chiều tăng của số hiệu 
 

   Vùng 2: Vùng thể hiện các số hiệu linh kiện trước khi đặt tự động 

  Vùng 3: Vùng thể hiện các số hiệu linh kiện sau khi đặt tự động 

  Vùng 4: Cập nhật số liệu cho vùng 3 

   Vùng 5: Thiết lập lại (Reset) tất cả các số hiệu của linh kiện về dấu ? 

   Vùng 6: Đưa số hiệu của linh kiện trở về số hiệu của các bước trước đó. 

   Vùng 7: Accept Changes (Create ECO) sẽ thực thi đặt số hiệu tự động 

❖ Bước 3: Thực hiện các bước từ 1 đến 3 theo Hình 4.54 để thay đổi số hiệu 

linh kiện 



Lưu ý: 

Theo dõi các Status Check và Done như trong hình 7.54. 

Nếu tất cả các dấu không phải là dấu tích màu xanh thì ta phải quay lại bản 

vẽ nguyên lý để kiểm tra nguyên nhân 

 

 

Hình 4.54. Bảng thông báo thực thi 
 

Ở bài tập này, ta sẽ xắp xếp linh kiện theo chiều từ dưới lên trên, sau đó từ trái 

qua phải 

Bản vẽ sau khi đánh số hiệu tự động: 

Hình 4.55. Các linh kiện sau khi được đánh số hiệu tự động 



 

 
 

4.2.5 Kiểm tra lỗi của bản vẽ nguyên lý 

❖ Bước 1: Vào menu Project > Compile Project .......... (phím tắt C C) 

Hình 4.56. Chức năng kiểm tra lỗi bản vẽ trong menu Project 

 

❖ Bước 2: Vào Workspace Panel System (Hình 4.57 chọn panel Messages 

Hình 4.54. Panel Messages trong Workspace System tại góc phải cuối vùng thiết 

kế  của Altium Designer 

 

❖ Bước 3. Kiểm tra các thông báo trong panel Messages 

   Nếu không có thông báo: Bản nguyên lý không có lỗi về thiết kế 

   Thông báo Warning: Bản vẽ có một số vấn đề, nhưng chưa thành lỗi. 

Nháy kép vào thông báo để tìm đến chỗ xảy ra vấn đề trong bản vẽ 

Ví dụ như trong Hình 4.58: 

Lưu ý: 

Nhấn tổ hợp phím T N để thực hiện nhanh chức năng đặt số hiệu tự động 

Nhấn tổ hợp phím T E để thực hiện nhanh chức năng Reset số hiệu về ? 



Lưu ý: 

Thông báo Warning vẫn cho phép chúng ta chuyển đổi từ bản vẽ nguyên lý 

sang bản vẽ mạch in. 

Nếu chúng ta không kiểm tra và sửa các warning quan trọng, bản thiết kế 

mạch in cuối cùng của chúng ta sẽ bị lỗi. 

 

 

Hình 4.58. Cảnh báo đối tượng nguồn GND bị trôi nổi 

 

Máy báo là GND Power Port bị “thả nổi”, không kết nối vào linh kiện. Việc 

của ta là kết nối lại GND Power Port vào chân của Led D1 

   Thông báo Error: Thông báo có lỗi xảy ra trong bản vẽ. Và trong trường 

hợp này, máy sẽ không cho phép chuyển đổi từ bản vẽ nguyên lý sang bản 

vẽ mạch in tới khi nào lỗi được khắc phục. 

Ví dụ như trong Hình 4.59 

Hình 4.59. Lỗi trùng số hiệu linh kiện 



Để khắc phục lỗi trùng số hiệu này, chúng ta nhấn tổ hợp phím T N để đánh số 

hiệu tự động lại cho bản vẽ 

Lưu ý: 

Một bài toán đặt ra cho chúng ta trong trường hợp máy báo Warning trên, đó 

là GND Power Port không được kết nối vào chân của led D2. Đây thực chất là một 

lỗi thiếu đường nguồn rất nghiêm trọng trong thiết kế mạch in. 

Altium Designer cho phép chúng ta lựa chọn các mức độ chấp thuận, cảnh báo 

hay thông báo lỗi trong quá trình biên dịch Project 

Các bước thay đổi mức độ cảnh báo như sau: 

❖ Bước 1: Ta chọn menu Project > Project Options… (phím tắt C O) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Hình 4.60. Bảng điều chỉnh mức độ cảnh báo lỗi 
 

❖ Bước 2: Lựa chọn các thông số và cân nhắc mức độ của vấn đề gặp phải sẽ 

nằm ở loại thông báo nào trong 4 loại 

Không thông báo (No Report) 

Cảnh báo (Warning) 

Thông báo lỗi (Error) 

Thông báo lỗi cực kì nghiêm trọng (Fatal Error) 

❖ Bước 3. Điều chỉnh thông báo lỗi Power Port bị “thả nổi” từ cảnh báo 

(Warning) thành lỗi nghiêm trọng (Fatal Error) như trong Hình 4.60 



 

 
 

Sau khi kiểm tra hết thông báo trong panel Messages, chúng ta đã hoàn thành 

bản vẽ nguyên lý, chuẩn bị cho cập nhật (Update) sang bản vẽ mạch in (PCB) 

Hình 4.62. Bản vẽ nguyên lý hoàn thiện 

❖ Bước 4: Nhấn CC để tiến hành bước kiểm tra 

Lúc này, vấn đề thả nổi GND Power Port đã được thông báo là “Lỗi rất 

nghiêm trọng” (Fatal Error) trong panel Messages 

 

 

 

 

 

 

 

 

 

 

 

 
Hình 7.61. Thông bá trôi nổi Power Object là lỗi nghiêm trọng (Fatal Error) 



4.2.6.Tạo mới một bản vẽ PCB 

❖ Bước 1: Từ Panel Project, nhấn chuột phải vào tên project Dao dong da 

hai.PrjPcb > Chọn Add new to Project > Chọn PCB 

Hình 4.63. Thêm một bản vẽ PCB vào Project 

 

❖ Bước 2: Trong Panel Project, nhấn chuột phải vào tên Pcb1.PcbDoc > Chọn 

Save > Đánh Dao dong da hai vào trường File name (vùng 3, Hình 4.64). 

Chỉnh lại đường dẫn cho bản PCB được lưu cùng trong thư mục Dao dong da 

hai (vùng 4, Hình 4.64) 

Chọn nút Save (vùng 5, Hình 4.63) để lưu file PCB vào ổ cứng 

Hình 4.64. Các bước lưu bản PCB vừa tạo vào ổ cứng 



Lưu ý: 

Những thiết lập mới của bản vẽ hay thay đổi về kết cấu Project sẽ được hiển 

thị bằng biểu tượng tài liệu màu đỏ trong Project Panel hoặc dấu sao (*) trên thanh 

tiêu đề của bản vẽ 

 

 

 

 

 

 

 

 

 

 

 

Hình 7.65. Biểu tượng có sự thay đổi mới (chưa lưu) 
 

Để đề phòng trong việc mất điện đột xuất hoặc máy gặp sự cố (treo máy, ….) 

bạn đọc nên tạo cho mình thói quen 3 đến 5 thao tác tiến hành lưu 1 lần (nhấn tổ 

hợp phím Ctrl S) 

❖  Bước 3: Nhấn chuột phải vào tên của Project, chọn Save Project để lưu 

lại thiết lập của Project 

4.2.7 Cập nhật (Update) từ bản vẽ nguyên lý sang bản vẽ mạch in 

❖ Bước 1: Từ bản vẽ nguyên lý, chọn menu Design > Update PCB Document … 

(phím tắt D U) 

Hình 4.66. Chưc năng Update sang PCB nằm trong menu Design 

 

❖ Bước 2: Thực hiện các bước từ 1 đến 4 trong bảng thực thi Hình 4.67 



Lưu ý: 

Trong thực tế, không cần nhấn Validate Changes (vùng 1, hình 1.67), chỉ cần 

nhấn nút Execute Changes (vùng 2, hình 7.67) là phần mềm đã thực hiện luôn 

công việc của Validate Changes 

Chỉ cần quan tâm đến báo lỗi ở cột Done (vùng 3, hình 7.67) 

 

 

Hình 4.64. Bảng thực hiện chuyển đổi từ nguyên lý sang PCB 
 

   Vùng 1: Theo dõi sự cập nhật của linh kiện, đường dây và sẽ thông báo trên 

cột Check tại vùng 3 

   Vùng 2: Thực thi, thông báo trên cột Done tại vùng 3 

  Vùng 3: Các thông báo (lỗi, cảnh báo….) 

   Vùng 4: Đóng bảng thực thi khi hoàn thành 

❖ Bước 3: Trong môi trường thiết kế PCB, nhấn tổ hợp phím Z A để nhìn thấy 

toàn bộ linh kiện vừa được cập nhật 

 
 

Hình 4.68. Các linh kiện được cập nhật từ bản vẽ nguyên lý sang bản vẽ PCB 



4.2.8.Sắp xếp linh kiện 

4.2.8.1 Một số quy tắc sắp xếp linh kiện 

   Các linh kiện nằm trong cùng một khối chức năng thì được sắp xếp gần nhau 

  Đối với các mạch thông thường, sắp xếp các linh kiện càng gần nhau thì 

mạch càng gọn đẹp 

   Đối với mạch đòi hỏi sự phối hợp trở kháng, dung kháng …hoặc phải theo 

chuẩn nào đó (card mạng, card âm thanh …) thì sắp xếp theo yêu cầu kĩ thuật 

của mạch đó 

   Các linh kiện có phát nhiệt (IC nguồn, các phần tử công suất) thì nên quay 

phần tản nhiệt ra mép mạch 

   Chiều của các linh kiện phải được sắp xếp theo chiều ngang hoặc dọc so với 

mạch, không nên để chéo 

7.2.9.1. Sắp xếp linh kiện trong mạch dao động đa hài 

❖ Bước 1: Thiết lập các thuộc tính của bản vẽ 

Nhấn phím D O trên bàn phím, bảng thuộc tính của bản vẽ hiện ra như trong 

Hình 4.69 

Hình 4.69. Các lựa chọn trong bảng thuộc tính của bản vẽ PCB 



Lưu ý: 

Nếu không quen sử dụng lưới, ta có thể xóa lưới bằng cách nhập 0 mm vào 

trường Grid 1 và Grid 2 

   Vùng 1: Thiết lập đơn vị của bản vẽ là mm (metric) 

   Vùng 2: Thiết lập bắt dính chuột vào lưới là 0.1 mm 

   Vùng 3: Thiết lập bắt dính linh kiện vào lưới là 0.5 mm 

   Vùng 4: Thiết lập bắt dính chuột vào đối tượng là 0.1 mm 

   Vùng 5: Thiết lập hiển thị lưới. Kiểu lưới là đường kẻ (Lines), lưới 1 là 

50mil, lưới 2 là 100 mil 

❖ Bước 2: Chọn vào Zoom > nhấn phím Delete trên bàn phím để xóa Zoom 

bao quanh linh kiện (vùng màu nâu bao quanh toàn bộ linh kiện sau khi 

update từ nguyên lý sang PCB) 

 

Hình 4.70. Vùng Zoom bao quanh linh kiện 

 

❖ Bước 3: Sang bên bản vẽ nguyên lý, kéo chọn những linh kiện cùng khối 

chức năng. Vào menu Tools > Select PCB Components (Phím tắt T S) 

Hình 4.71. Lựa chọn linh kiện có cùng khối chức năng 



 

 

Lúc này, phần mềm sẽ tự chuyển sang bản vẽ PCB và cách linh kiện được chọn 

bên bản vẽ nguyên lý cũng sẽ được chọn các linh kiện bên PCB 

Hình 4.73. Các linh kiện được tự động chọn giống như bên nguyên lý 

 

❖ Bước 4: Chọn công cụ Arrange Components Inside Area trong thanh công cụ 

Utility 

Lưu ý: 

Linh kiện được chọn sẽ có 4 ô vuông màu (xanh lục, xanh nhạt, đỏ) bao quanh 

thân linh kiện 

Linh kiện chưa được chọn sẽ có 4 ô vuông không màu bao quanh 

 

 

 

 

 

 

 

 

 
 

Hình 7.72. Phân biệt giữa linh kiện được chọn và chưa được chọn trong bản  

vẽ nguyên lý 



Lưu ý: 

Khi chọn vào vị trí có nhiều đối tượng đè lên nhau, sẽ có một bảng thông báo 

hiện lên, cho phép ta chọn đúng đối tượng mong muốn. 

Hình 4.74. Công cụ sắp xếp linh kiện trong vùng 

 

Nhấn giữ chuột trái, kéo chọn một vùng trong vùng làm việc (màu đen) để đưa 

những linh kiện được chọn vào vùng làm việc 

❖ Bước 5: Thực hiện lại các bước từ 1 đến 4 để đưa toàn bộ linh kiện theo từng 

nhóm chức năng vào vùng làm việc (màu đen) 

Hình 4.75. Các linh kiện được sắp xếp theo khối chức năng 

 

Bước 6: 

   Tiến hành sắp sếp các linh kiện trong cùng một khối chức năng 

  Ghép các khối chức năng với nhau 

   Điều chỉnh lại một số linh kiện cho phù hợp với không gian mạch 
 

 

Hình 4.76. Linh kiện được sắp xếp hoàn thiện 
 



 

 
 

7.1.2. Đặt luật chạy mạch (Rule) 

Luật (Rule) quy định toàn bộ các thông số như: 

+ Độ rộng đường mạch, 

+ Khoảng cách giữa các đường mạch 

+ Khoảng cách giữa các linh kiện 

+ Khoảng bẻ góc đường mạch 

+ Độ rộng, vị trí đặt lỗ Via 

+ Lớp chạy đường mạch 

+ Độ ưu tiên của đường mạch 

+ …… 

Các vấn đề trong việc sắp xếp, đi dây đường mạch nằm ngoài khoảng quy định 

của luật tương ứng sẽ được máy báo lỗi 

Các chức năng, nhiệm vụ, và ý nghĩa của các luật sẽ được nói rõ trong phụ lục 

03 – Luật trong thiết kế mạch in bằng Altium Designer 

Các bước đặt luật cho mạch 

 

 

 

 

 

 

 

 

 

Hình 7.77. Cho phép lựa chọn đối tượng Text hay linh kiện C1 khi tại vị trí chọn, có 2 

đối tượng lồng lên nhau 
 

Khi di chuyện các thành phần của một linh kiện, thì toàn bộ linh kiện đó sẽ 

sáng lên, và các linh kiện khác thì tối đi 

 

 

 

 

 

 
Hình 7.78. Transistor Q2 sáng lên và các linh kiện khác tối đi khi di chuyển chữ Q2 



Lưu ý: 

Nhấn vào dấu cộng (+) ở bên trái các mục để vào các mục con hoặc luật 

❖ Bước 1: Chọn menu Design > Rules (Phím tắt D R) để mở bảng các thông  

số luật (Hình 4.79) 

Hình 4.79. Bảng các thông số về luật 
 

❖ Bước 2: Đặt luật về khoảng cách giữa các đường mạch 

   Vào mục Design Rules > Electrical > Clearance > Clearance (vùng 1, 

Hình 4.80) 

   Đặt thông số khoảng cách nhỏ nhất giữa các đường mạch là : 0.6mm (vùng 

2, Hình 4.80) 

   Nhấn Apply để hoàn thành 



 

 

Hình 4.80. Thiết lập luật về khoảng cách đường mạch 

 

❖ Bước 3: Đặt luật về độ rộng của đường mạch 

   Vào mục Design Rules > Routing > Width > Width (vùng 1, hình 1.81) 

  Đánh vào trường Name (vùng 2, Hình 4.81): Duong nguon 

   Chọn bề rộng của đường nguồn (vùng 3, Hình 4.81) 

+ Bề rộng nhỏ nhất (Min Width): 1 mm 

+ Bề rộng tham chiếu ( Preferrend Width): 1 mm 

+ Bề rộng lớn nhất (Max Width): 1 mm 

   Nhấn vào nút Query Builder….(vùng 4, Hình 4.81) 



 

 

Hình 4.81. Thiết lập độ rộng của đường cấp nguồn 
 

   Thiết lập các thông số như (Hình 4.82) 

Hình 4.82. Sử dụng Query Builder trong xác định điều kiện áp dụng luật cho đường 

nguồn 



+ Nhấn chuột vào vùng 1, chọn Belong To Net 

+ Nhấn chuột vào vùng 2, chọn +5V 

+ Nhấn chuột vào vùng 3, chọn Belong To Net 

+ Nhấn chuột vào vùng 4, chọn GND 

+ Nhấn chuột vào vùng 5, chọn điều kiện OR 

+ Các thiết lập sẽ được xem trước ở vùng 6 

+ Nhấn OK để hoàn thành 

   Kiểm tra lại bảng thông số cuối cùng của đường nguồn (như Hình 4.83) 

Hình 4.83. Bảng thông số luật của đường nguồn 
 

   Nhấn chuột phải vào mục Width, chọn New Rule… để thêm luật cho các 

đường mạch khác (Hình 4.84) 



 

 
 
 

Hình 4.84. Thêm một luật cho độ rộng đường mạch 
 

   Chọn các thông số cho các đường mạch còn lại (không phải đường nguồn) 

như Hình 4.85 

Hình 4.85. Thông số về độ rộng của các đường tín hiệu 

 

+ Trường Name (vùng 2): Tin hieu 

+ Chữ Width mới được tạo ở vùng 1sẽ trở thành Tin hieu 

+ Vùng 3 Chọn Min: 0.5 mm, Pref: 0.8 mm, Max: 1 mm 

+ Nhấn Apply để hoàn thành 



❖ Bước 4: Thiết lập cấu trúc chạy đường mạch (có tác dụng trong đi mạch tự 

động - Auto route) 

   Chọn Routing Topology > Routing ToPology 

   Trong trường Topology, chọn Shortest (ngắn nhất) 

  Nhấn Apply để hoàn thành 

Hình 4.86. Thiết lập cấu trúc chạy đường mạch 

 

❖ Bước 5: Thiết lập quyền ưu tiên chạy đường mạch 

   Vào mục Routing Priority > Routing Priority (vùng 1, Hình 4.87) 

  Đánh vào trường Name (vùng 2, Hình 4.87): Uu tien nguon 

   Trường Routing Priority (vùng 2, Hình 4.87) chọn 1 

   Nhấn vào nút Query Builder….(vùng 4, Hình 4.87) 



 

 

Hình 4.84. Thiết lập chế độ ưu tiên chạy mạch cho đường nguồn 
 

   Thiết lập các thông số như (Hình 4.88) 

Hình 4.88. Sử dụng Query Builder trong xác định điều kiện áp dụng luật cho đường 

nguồn 

 

+ Nhấn chuột vào vùng 1, chọn Belong To Net 

+ Nhấn chuột vào vùng 2, chọn +5V 

+ Nhấn chuột vào vùng 3, chọn Belong To Net 



+ Nhấn chuột vào vùng 4, chọn GND 

+ Nhấn chuột vào vùng 5, chọn điều kiện OR 

+ Các thiết lập sẽ được xem trước ở vùng 6 

+ Nhấn OK để hoàn thành 

   Kiểm tra lại bảng thông số cuối cùng về chế độ ưu tiên của đường nguồn 

(như hình 1.89) 

Hình 4.89. Bảng thông số luật ưu tiên của đường nguồn 
 

   Nhấn chuột phải vào mục Routing Priority, chọn New Rule… để thêm luật 

cho các đường mạch khác (Hình 4.90) 

Hình 4.90. Thêm một luật cho độ ưu tiên đường mạch 
 

   Chọn các thông số cho các đường mạch còn lại (không phải đường nguồn) 

như Hình 4.91 



 

 

Hình 4.91. Thông số về độ ưu tiên của các đường tín hiệu 

 

+ Trường Name (vùng 2): uu tien tin hieu 

+ Chữ Routing Priority mới được tạo ở vùng 1sẽ trở thành uu tien tin hieu 

+ Vùng 3 Chọn Routing Priority: 2 

+ Nhấn Apply để hoàn thành. 

 
❖ Bước 6: Thiết lập lớp chạy đường mạch 

   Vào mục Routing Layer > Routing Layer (vùng 1, Hình 4.92) 

   Trong trường Enabled Layer, tích chọn Bottom Layer, bỏ chọn Top 

Layer trong cột Allow Routing (Vùng 2, Hình 4.92) 

Như vậy là trong bài này, ta chỉ cho đường mạch chạy ở lớp dưới (Bottom 

Layer) 

   Nhấn Apply để hoàn thành 



 

 

Hình 4.92. Thiết lập lớp chạy đường mạch 

 

❖ Bước 7: Thiết lập kích thước lỗ Via 

   Vào mục Routing Via Style > Routingvias (vùng 1, Hình 4.93) 

   Trong trường Via Diameter (đường kính Via) (vùng 2, Hình 4.93): 

Min = Max = Pref = 1.5 mm 

   Trong trường Via Hole Size (kích thước lỗ Via) (vùng 3, Hình 4.93): 

Min = Max = Pref = 0.8 mm 

   Nhấn Apply để hoàn thành 

Hình 4.93. Thiết lập kích thước lỗ Via 



❖ Bước 8: Thiết lập độ rộng của đường kết nối giữa lớp phủ đồng đến chân linh 

kiện có cùng Net 

   Vào mục Design Rules > Plane > Polygon Connect Style > Polygon 

Connect (vùng 1, Hình 4.94) 

   Vùng 2: Kiểu kết nối: Relief Connect 

   Vùng 3: Số mối nối: 4 

   Vùng 4: Góc nối: 90 độ 

   Vùng 5: Bề rộng : 0.5 mm 

   Nhấn Apply để hoàn thành 

Hình 4.94. Thiết lập đường kết nối với lớp phủ đồng 

 

 
❖ Bước 9: Thiết lập các điều kiện về quá trình sản xuất 

   Vào mục Design Rules > manufacturing (vùng 1, Hình 4.95) 

   Tích chọn vào NetAntennae ở cột Enabled, còn tất cả những luật khác đều 

bỏ chọn (vùng 2, Hình 4.95) 



Lưu ý: 

Nếu muốn cấm một luật nào đó không thực thi, ta chỉ cần chọn vào thư mục 

mẹ của luật đó và bỏ dấu tích tại cột Enabled 

   Nhấn Apply để hoàn thành 
 

 

Hình 4.95. Không cho phép một số luật ở Manufacturing được thực thi 
 

 

❖ Bước 10: Thiết lập về khoảng cách sắp xếp linh kiện 

   Vào mục Design Rules > Placement > Component Clearance > 

ComponentClearance (vùng 1, Hình 4.96) 

   Vùng 2: Chọn Specified 

   Vùng 3: Khoảng cách nhỏ nhất theo chiều ngang: 0.2 mm 

  Vùng 4: Khoảng cách nhỏ nhất theo chiều dọc: 0.2 mm 

  Nhấn Apply để hoàn thành 



 

 

Hình 4.96. Thiết lập về khoảng cách giữa các linh kiện 

 

❖ Bước 11: Kiểm tra lại bảng tổng hợp luật 

Hình 4.94. Bảng tổng hợp luật của thiết kế 

 

❖ Bước 12: Nhấn OK để hoàn thành bước đặt luật 



4.2.10. Đi đường mạch 

4.2.101 Đi đường mạch tự động 

❖ Bước 1: Chọn menu Auto Route > All…(Phím tắt Alt A A) 

Hình 4.98. Chức năng đi đường mạch tự động 

 

❖ Bước 2: Kiểm tra, chỉnh sửa và chạy mạch 

Hình 4.99. Bảng thông báo trạng thái và chế độ đi đường mạch tự động 



   Vùng 1: Thông báo có xung đột gì về luật hay không. Nếu màu xanh thì luật 

được đặt là đúng, không có xung đột gì 

   Vùng 2: Điều chỉnh hướng đi đường mạch 

   Vùng 3: Sửa lại luật nếu có thông báo xung đột từ vùng 1 

  Vùng 4: Các chế độ chạy tự động mặc định 

   Vùng 5: Tiến hành chạy tự động nếu tất cả các điều kiện đều thỏa mãn 

❖ Bước 3: Chờ mạch chạy hoàn thiện, theo dõi thông báo trên panel Messages 

Hình 4.100. Thông báo trạng thái đi mạch tự động trong panel Messages 
 

   Routing finished : Đã đi dây xong 

   0 Contentions: Số đoạn có đường đè lên nhau (chập mạch) : 0 

   Failed to complete 0 connections: Số đường không được đi mạch (đứt 

mạch): 0 

❖ Bước 4: Chọn chuột vào đường mạch, chỉnh lại đường mạch cho đẹp 



 

 

Hình 4.101. Mạch in (PCB) của mạch dao động da hài bằng phương pháp đi 

đường mạch tự động 

 

4.2.10.2 Đi đường mạch thủ công 

❖ Bước 1: Chọn lớp Bottom Layer 

   Cách 1: Chọn vào thẻ Bottom Layer trong thanh công cụ Manage Layer 

Sets 

Hình 4.102. Chọn lớp Bottom Layer trong thanh công cụ Layer Manager 



   Cách 2: Nhấn tổ hợp phím Ctrl Shift và cuộn chuột 

   Cách 3: Nhấn phím dấu sao (*) bên bàn phím số 

❖ Bước 2: Làm tối đi các lớp không cần thiết, tránh rối mắt trong quá trình đi 

đường mạch 

Nhấn vào biều tượng DXP > Preferences …(phím tắt T P) 

Hình 4.103. Vào chức năng thiết lập  hệ thống 
 

   Vào PCB Editor > Board Insight Display 

   Tích chọn vào 3 lựa chọn như vùng 3 Hình 4.106 

  Nhấn OK để hoàn thành 

Hình 4.104. Điều chỉnh thông số trong Board Insight Display 
 

   Trong môi trường vẽ mạch in (PCB), ta nhấn Shift S để làm tối các lớp 

không cần thiết. 

Có thể nhấn Shift S nhiều lần để làm tối như mong muốn. 

   Có 4 mức tối: 

+ Mức 1: Không tối 

+ Mức 2: Tối xám 

+ Mức 3: Tối đen 

+ Mức 4: Tối hoàn toàn 



Lưu ý: 

Khi một đường mạch đang được nối, thì nó sẽ sáng lên. 

Khi muốn kiểm tra một mối nối nào đó, ta giữ Ctrl và nhấn chuột trái, mối 

nối đó cũng sẽ được sáng lên 

Muốn tất cả các đường cùng sáng trở lại, ta nhấn phím Shift C hoặc nút Clear 

❖ Bước 3: Gọi chức năng đi đường mạch thủ công 

   Cách 1: Vào menu Place > Interactive Routing (phím tắt P T) 

Hình 4.105. Chức năng đi mạch thủ công trong menu Place 
 

   Cách 2: Chọn vào biểu tượng Interactively Route Connections trên thanh 

công cụ Writing 

Hình 4.106. Chức năng đi mạch tự động trên thanh công cụ Writing 

 

❖ Bước 4: Đưa chuột vào chân linh kiện và bắt đầu đi đường mạch theo các 

đường nối có sẵn (đường có màu trắng, mảnh) 

Hình 4.104. Đi đường mạch theo các đường nối có sẵn 
 



 

 

Mạch sau khi đi mạch thủ công: 
 

 

Hình 4.108. Đi mạch theo phương pháp thủ công 

tại góc cuối bên phải màn hình làm việc 

Nháy kép chuột trái để chốt một đường mạch tại một vị trí nào đó 

Muốn hủy một lệnh vẽ đang được thực thi, ta nhấn chuột phải hoặc phím 

ESC trên bàn phím 
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3.6. Bài tập ví dụ 

Bài 1: Vẽ mạch khuếch đại Emiter chung dùng transistor theo kiểu cầu phân áp 

Hình 4.109. Sơ đồ nguyên lý của mạch khuếch đại EC 

 

Gợi ý: Bảng thông số của linh kiện: 
 

T 

T 

 
Chủng loại 

 
Thư viện 

Tên 

trong 

thư viện 

Số 

hiệu 

Số 

lượng 

 
Comment 

 
Value 

 
Ghi chú 

1 Điện trở 
Miscellaneous 

Devices 
Res1 R? 4 

100K, 1K, 

270K, 2K2 

100K, 1K, 

270K, 2K2 

Trở 

thường 

 
2 

Transistor 

NPN 

Miscellaneous 

Devices 

 
NPN 

 
Q? 

 
2 

 
C1815 

 
2SC1815 

Đổi lại 

thứ tự 

chân 

3 Tụ điện 
Miscellaneous 

Devices 

Cap 

Pol1 
C? 3 10uF/16V 10uF/16V Tụ hóa 

 

 

4 

 

 

Cọc đấu 

 

 
Miscellaneous 

Connectors 

 

 
Header 

2 

 

 

P? 

 

 

2 

 

 
5A Blue 

Header 2 

 

 

IN, OUT 

Cọc 

đấu 

nguồn 

kiểu 

vặn 

dây 

Bảng 4.3. Bảng thông số linh kiện của bài tập thực hành 
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BÀI 5: KỸ THUẬT HÀN 

Giới thiệu: 

- Trong cơ khí, kỹ thuật hàn đóng vai trò cực kỳ quan trọng, giúp đánh giá 

được chất lượng đào tạo nguồn nhân lực. Trong ngành điện tử việc thành thạo các 

kỹ năng hàn linh kiện điện tử cũng như việc trang bị kiến thức tương đối hoàn thiện 

về linh kiện điện tử sẽ giúp cho sinh viên khỏi bỡ ngỡ khi ra truong đi làm. 

Mục tiêu: 

- Sử dụng được các dụng cụ cầm tay nghề điện tử đúng kỹ thuật 

- Hàn đúng tiêu chuẩn kỹ thuật  

- Tháo hàn an toàn cho mạch điện và linh kiện  

- Rèn luyện tính tỷ mỉ, chính xác, an toàn và vệ sinh công nghiệp 

1. Giới thiệu bộ dụng cụ cầm tay. 

Mục tiêu: 

- Sử dụng được các dụng cụ cầm tay nghề điện tử đúng kỹ thuật 

1.1.  Dụng cụ hàn 

 Dụng cụ hàn bao gồm: Mỏ hàn và đế mỏ hàn (xem hình vẽ 1) 

- Mỏ hàn là dụng cụ được sử dụng để nung nóng chảy chì hàn, giúp hàn 

chặt chân linh kiện với bảng mạch, hay giữa các linh kiện với nhau. 

- Đế mỏ hàn: là nơi giữ mỏ hàn khi không dùng (vẫn còn nóng). Vì khi 

đang sử dụng mỏ hàn rất nóng và có thể gây nguy hiểm cho người sử dụng 

cũng như các vật dụng xung quanh nếu chạm phải. Ngoài ra đế mỏ hàn cũng là 

nơi giữ nhựa thông để thuận tiện hơn cho công việc hàn mạch. 

 
Hình 1.1. Mỏ hàn và đế mỏ hàn. 

❖ Cách sử dụng mỏ hàn: (Thời gian đầu có thể cho 2 sinh viên cùng hàn một 

board mạch, một người giữ linh kiện người còn lại hàn, sau đó hoán đổi lại vai trò 

cho nhau). 

- Chấm mỏ hàn vào nhựa thông để rửa sạch mỏ hàn, giúp việc hàn mạch dễ 

dàng hơn. 

-  Cho mỏ hàn tiếp xúc với mối hàn để truyền nhiệt 
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- Cho chì hàn vào mối hàn, chì hàn sẽ chảy đều khắp mối hàn. 

-  Đồng thời rút chì hàn và mỏ hàn ra khỏi mối hàn. 

- Kiểm tra lại mối hàn: 

+ Mối hàn phải chắc chắn. 

+ Mối hàn ít hao chì. 

+  Mối hàn bóng đẹp. 

❖ Mỏ hàn điện sử dụng điện trở đốt nóng, không dùng dạng mỏ hàn đốt nóng theo 

nguyên lý ngắn mạch thứ cấp biến áp. Công suất của mỏ hàn thông thường là 40W. 

Sử dụng mỏ hàn với công xuất lớn hơn thì có thể phát sinh các vấn đề sau: 

- Nhiệt lượng quá lớn từ mỏ hàn khi tiếp xúc với linh kiện có thể làm hỏng 

linh kiện. 

- Nhiệt lượng quá lớn gây tình trạng oxy hóa bề mặt các dây dẫn bằng đồng 

ngay lúc hàn, và mối hàn lúc này sẽ khó hàn hơn. Ngoài ra nhiệt lượng lớn cũng có 

thể làm cháy nhựa thông (dùng kèm khi hàn) và bám thành lớp đen tại mối hàn, 

làm giảm độ bóng và tính thẩm mỹ của mối hàn. 

- Nhiệt lượng quá lớn đòi hỏi người sử dụng phải khéo léo để truyền nhiệt 

thật nhanh và đủ vào nơi hàn. 

- Nhiệt lượng quá lớn cũng có thể làm gãy mũi hàn. 

❖ Một vài điểm lưu ý khi sử dụng mỏ hàn: 

- Sau khi hàn xong phải tắt mỏ hàn ngay, để bảo vệ mỏ hàn. Tránh tình 

trạng gãy mũi mỏ hàn do vẫn cấp nguồn cho mỏ hàn quá lâu mà không dùng. 

- Mỏ hàn khi tạm thời không sử dụng phải đặt ngay vào đế mỏ hàn, tránh 

gây nguy hiểm cho các vật xung quanh cũng như người dùng. 

1.2.  Chì hàn và nhựa thông 

1.1.1  Chì hàn:(xem hình 1.2)  

Chì hàn được sử dụng để kết nối mối hàn. 

 
Hình 1.2.  Chì hàn. 

- Chì hàn dùng trong quá trình lắp ráp các mạch điện tử là loại chì hàn dễ 
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nóng chảy, nhiệt độ nóng chảy khoảng 60oC đến 80oC. Loại chì hàn thường gặp 

trong thị trường Việt Nam ở dạng sợi ruột đặc (cuộn trong lõi hình trụ), đường kính 

sợi chì hàn khoảng 1mm. Sợi chì hàn này đã được bọc một lớp nhựa thông ở mặt 

ngoài (đối với một số chì hàn của nước ngoài, thì lớp nhựa thông này thường 

nằm ở trong lõi của sợi chì hàn). Lớp nhựa thông này dùng làm chất tẩy ngay 

trong quá trình nóng chảy chì tại điểm cần hàn. 

- Đối với những loại chì hàn có bọc sẵn một lớp nhựa thông thì màu sắc của 

nó sẽ bóng hơn là những sợ chì không có lớp nhựa thông bên ngoài. 

1.1.2.   Nhựa thông:( xem hình 1.3) 

- Nhựa thông có tên gọi là chloro-phyll, nó là một loại diệp lục tố lấy từ cây 

thông, thường thì nhựa thông ở dạng rắn, có màu vàng nhạt (khi không chứa 

tạp chất). 

- Ngoài việc sử dụng nhựa thông trong lúc hàn thì nhựa thông còn được 

pha với hỗn hợp xăng và dầu lửa để phủ lên mạch in, nhằm mục đích bảo vệ mạch 

in tránh bị oxy hóa, đồng thời giúp cho việc hàn mạch in sau này được dễ dàng 

hơn. Ngoài ra việc phủ một lớp nhựa thông trên mạch in còn tăng tính thẩm mỹ cho 

mạch in. 

 

 

 
Hình 1.3. Nhựa thông. 

❖ Công dụng của nhựa thông: 

- Rửa sạch (chất tẩy) nơi cần hàn để chì dễ bám chặt. 

-  Sau khi hàn thì nhựa thông sẽ phủ trên bề mặt của mối hàn làm cho mối 

hàn bóng đẹp, đồng thời nó sẽ cách ly mối hàn với môi trường xung quanh 

(tránh bị oxy hóa, bảo vệ mối hàn khỏi nhiệt độ, độ ẩm, …) 
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- Giảm nhiệt độ nóng chảy của chì hàn. 

❖ Các lưu ý khi sử dụng chì hàn và nhựa thông 

- Chì hàn khi hàn nên đưa vào mối hàn, tránh đưa chì hàn vào mỏ hàn (mỏ 

hàn có thể hút chì hàn gây hao chì). 

-  Khi sử dụng nhựa thông nên để vào đế mỏ hàn để tránh vở vụn nhựa 

thông. 

1.3. Kềm  

Trong quá trình lắp ráp, sửa chữa thông thường ta phải dùng đến hai loại 

kềm thông dụng đó là: kềm cắt và kềm mỏ nhọn (đầu nhọn). 

1.3.1. Kềm cắt (xem hình 1.4) 

 

Hình 1.4. Kềm cắt 

❖ Công dụng: 

- Cắt chân linh kiện trong quá trình hàn mạch. 

- Cắt các đoạn dây chì. 

- Cắt dây dẫn nối mạch. 

❖ Lưu ý: 

- Mỗi loại kềm cắt chỉ cắt được dây dẫn có đường kính tối đa thích hợp. 

- Nếu dùng các loại kềm cắt nhỏ để cắt các vật dụng có đường kính quá 

lớn có thể làm hư hỏng kềm. 

1.3.2. Kềm mỏ nhọn(xem hình 1.5) 
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Hình 1.5. Kềm mỏ nhọn 

❖ Công dụng: 

- Dùng để giữ các đoạn dây đồng (khi xi chì). 

- Dùng để giữ các chân linh kiện khi hàn. 

- Dùng để giữ các đoạn dây. 

- Dùng để bóc vỏ dây dẫn. 

❖ Lưu ý: 

- Không dùng kềm mỏ nhọn để bẻ các vật cứng vì nó có thể gây hỏng 

kềm (nên dùng kềm kẹp mỏ bằng để bẻ hay uốn các vật cứng). 

- Không dùng kềm này như búa. Vì điều này sẽ làm cho kềm mỏ nhọn bị 

cứng khi mở ra hay đóng lại, gây khó khăn khi sử dụng. 

1 . 4 .  Các dụng cụ khác: 

Ngoài các dụng cụ thông thường đã được giới thiệu ở trên thì trong lúc 

thực hành, sinh viên cũng cần sử dụng thêm một vài loại dụng cụ khác: 

- Dao: Sử dụng để cạo sạch lớp oxit bao quanh dây, đoạn chân linh kiện hay 

mối hàn. Dao còn sử dụng để gọt lớp nhựa bao quanh dây dẫn. 

- Giấy nhám: Sử dụng thay thế dao khi cần phải làm sạch lớp oxit. 

- Nhíp gắp linh kiện: sử dụng để tháo hoặc lắp linh kiện trên mạch. 

 2. Phương pháp hàn và tháo hàn 

2.1.  Kỹ thuật  hàn nối, ghép 

❖ Phương pháp hàn trên dây đồng 

Để hàn được hai dây đồng dính được vào với nhau thì cũng là một nghệ 

thuật. Cái này nó cũng gần giống như với sắt. 

- Dùng dao hay giấy nhám đánh sạch lớp oxyt hay lớp men bọc quanh dây 

(nếu dùng dây đồng tráng men ê may). Dây được xem là sạch khi ửng màu đồng 
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(màu hồng nhạt), bóng đều quanh vị trí vừa được làm sạch. Điều quan trọng cần 

chú ý, sau khi làm sạch ta phải thực hiện việc xi chì ngay, vì nếu để lâu, lớp oxyt sẽ 

phát sinh lại. Tuy nhiên, trên các vị trí vừa làm sạch lớp oxyt, nếu ta dùng mỏ hàn 

có công suất quá lớn (phát sinh nhiều nhiệt lượng) để hàn cũng phát sinh lại lớp 

oxyt tại điểm hàn do sự quá nhiệt. 

- Muốn xi chì, đầu tiên phải làm nóng dây dẫn cần xi, ta đặt đầu mỏ hàn bên 

dưới dây cần xi để truyền nhiệt (dây dẫn và đầu mỏ hàn đặt vuông góc). Khi truyền 

nhiệt, quan sát màu hồng của dây, màu hồng sẽ sẫm dần khi nhiệt độ gia tăng, 

trong khi quan sát ta đưa chì hàn (có bọc nhựa thông) tiếp xúc lên dây dẫn, chì hàn 

đặt khác phía với đầu mỏ hàn. 

- Khi điểm cần xi đủ nhiệt, chì hàn sẽ chảy ra và bọc quanh dây tại điểm cần 

xi, chì loang từ mặt trên xuống phía dưới (đi về phía nguồn nhiệt, tức đầu mỏ hàn). 

Nhờ thao tác này, nhựa thông có sẵn trong chì tan trước tẩy sạch điểm xi, tránh 

oxyt hóa, đồng thời chì nóng chảy sau dễ bám lên dây. Tuy nhiên, nếu đưa quá 

nhiều chì vào điểm xi (quá mức yêu cầu), lớp xi quá dày hoặc bị bám màu nâu do 

nhựa thông chảy ra và cháy trên điểm xi. 

- Dây đồng luôn phải tiếp xúc với đầu mỏ hàn và thực hiện liên tục theo 

nguyên tắc tiến hai bước lùi một bước và xoay tròn dây đồng, mỗi bước khoảng 

2mm. Điều quan trọng cần nhớ (khi thực hiện lần lượt các điểm xi kế tiếp nhau), tại 

khớp tiếp giáp giữa hai khoảng xi phải thực hiện sao cho không có sự tích tụ chì 

thành lớp dày trên đó. 

Chú ý: trong quá trình xi chì, ta tránh các động tác sau: 

- Dùng đầu mỏ hàn kéo rê chì trên dây cần xi, vì sẽ làm cho lớp chì không 

bám  hoàn toàn trên dây dẫn, đồng thời lớp chì bị đánh sọc theo đường kéo rê đầu 

mỏ hàn. Một nhược điểm nữa của động tác này là chì xi không bóng mà ngả màu 

xám do thiếu nhiệt và nhựa thông. 

- Đặt dây cần xi lên miếng nhựa thông, rồi dùng đầu mỏ hàn đặt tiếp xúc lên 

dây (làm nóng chảy nhựa thông và nóng dây), sau đó đưa chì hàn lên đầu mỏ hàn 

làm chảy chì và bám vào dây. Với động tác này, ta tránh được sự oxyt hóa bề mặt 

dây dẫn trong quá trình xi chì, dễ làm chì bám lên dây, tuy nhiên, do lượng nhựa 

thông chảy quá nhiều sẽ bám lên bề mặt dây sau khi xi làm dây không bóng và 

nhựa thông cháy dễ bám thành một lớp đen trên bề mặt xi chì của dây. 

 

 
2.1.1. Hàn nối hai đầu dây dẫn (xem hình 1.6) 
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 Phương pháp hàn này còn gọi là mối hàn ghép đỉnh. Ta dùng phương pháp 

này khi muốn tạo các đoạn dây dẫn hình đa giác hoặc có thể nối dài hai dây dẫn 

ngắn. Tuy nhiên, mối hàn này khó thực hiện và có độ bền cơ kém hơn các kiểu 

khác. 

 
 

Hình 1.6:. Mối ghép nối 

2.1.2. Mối hàn ghép song song (xem hình 1.7) 

Thường dùng để nối hai dây dẫn với nhau. Khoảng cách giao nhau thường 

được chọn tuỳ theo yêu cầu. Trong quá trình thực tập nên chọn khoảng cách giao 

nhau ngắn nhất là 5mm rồi tăng dần theo trình độ. 

 
Hình 1.7: Mối ghép song song 

2.1.3. Mối hàn ghép vuông góc 

Mối hàn đạt yêu cầu phải tạo chì bám xung quanh điểm đặt hai dây dẫn vuông 
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góc. 

 
Hình 1.8: Mối ghép vuông góc 

2.2. Hàn mạch in 

Hàn mạch in là quá trình hàn các linh kiện cắm hoặc linh kiện dán lên board 

mạch in. 

2.2.1. Kỹ thuật hàn xuyên lỗ 

-  Bước 1: Làm sạch bản mạch trước khi hàn linh kiện. 

+ Trước khi hàn linh kiện chúng ta phải làm sạch bản mạch in bằng giấy 

nhám nhuyễn để loại bỏ lớp đồng oxit trên board (đặc biệt tại điểm hàn) để 

đảm bảo mối hàn dính thiếc với tỷ lệ diện tích bề mặt cao. Công việc này rất 

quan trọng đối với những bản mạch chưa được phủ thiếc. Để làm sạch các 

điểm hàn bằng đồng chúng ta có thể dùng một cục cao su bào mòn hoặc một 

vật liệu tương tự. 

- Bước 2: Vệ sinh đầu mỏ hàn  trước khi hàn. 

+ Chùi sạch đầu mỏ hàn bằng Cleaning Wire (giống như miếng chùi nồi)  mỗi 

lần trước khi hàn xem hình 1.9. 

 

Hình 1.9 
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- Bước 3: Tráng chì hàn vào đầu mỏ hàn. 

+ Dùng nhựa thông và chì hàn nóng chảy đặc để tráng đầu mỏ hàn trước mỗi 

lần hàn. Chú ý không để  chì hàn bám dính quá nhiều ở đầu mỏ hàn.  

-  Bước 4: Cắm linh kiện vào lỗ hàn: 

+ Linh kiện là điện trở bẻ gập chân linh kiện bằng kìm vừa theo khoảng cách 

của 2 lỗ hàn. 

+ Cắm linh kiện vào lỗ hàn. 

+ Bẻ nghiêng chân linh kiện phía bên mặt hàn để linh kiện bám vào bản 

mạch in tránh trường hợp linh kiện bị rơi ra khi hàn, ngoài ra việc bẻ 

nghiêng chân linh kiện cũng có tác dụng tăng độ bền vật lý cho linh kiện 

trong quá trình sử dụng. 

-  Bước 5: Bấm chân linh kiện. 

+ Chúng ta thường hay thực hiện khâu bấm chân linh kiện sau khi hàn vì làm 

theo cách này dễ hơn, tránh việc linh kiện rơi ra khỏi mach in khi bấm chân. 

Thực ra cách này không có lợi cho bản mạch in. Tốt nhất nên bấm chân linh 

kiện trước khi hàn. 

-  Bước 6: Làm nóng chân linh kiện và điểm hàn. 

+ Đặt đầu mỏ hàn tiếp xúc đồng thời với chân linh kiện và điểm hàn để nung 

nóng cả hai cùng một lúc. Nhiều người chỉ chú tâm nung nóng điểm hàn trên 

bản mạch in và kết quả là lá đồng trên bản mạch in dễ bị bung ra hoặc chì 

hàn bao phủ xung quanh chân linh kiện nhưng không có sự tiếp xúc về mặt 

điện hay đôi khi nếu có thì độ bền vật lý của mối hàn cũng không cao. 

❖ Loại bỏ mối hàn 

         Hàn nhầm, hỏng là chuyện bình thường trong lúc làm mạch. Việc loại bỏ mối 

hàn cũng khá đơn giản. Sau đây là cách loại bỏ mối hàn thông thường. 

- Cách 1: Dùng dây đồng hút chì hàn 

+Làm nóng dây đồng. 

+Làm chảy mối hàn. 

+Dùng dây đồng hút hết chì hàn. 

Cách này không  được ưa chuộng vì hút không sạch mối hàn. 

- Cách 2: Dùng ống hút chì 
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Hình 1.10: Hút chì 

❖ Đánh giá 

- Sản phẩm xi: một lớp chì mỏng, bóng, phủ đều khắp dây đồng và ít hao chì. 

- Chắc chắn: đảm bảo không hở mạch khi có chấn động hoặc sử dụng 

lâu dài. 

- Sản phẩm hàn: chắc chắn, bóng, ít hao chì. 

❖     Thực hành 

Sử dụng dây đồng 1mm để hàn mắc lưới 10x10 cm (kích cỡ mỗi mắc lưới là 

1x1 cm) (hình 1.11). 

-  

Hình 1.11 

2.3. Kỹ thuật hàn IC dán 

2.3.1. Những dụng cụ cần thiết 

❖ Dụng cụ yêu cầu 

-  Mỏ hàn. 
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-  Chì hàn. 

- Nhựa thông. 

-  Panh gắp linh kiện. 

-  Board mạch SMD 

 

-  Các linh kiện SMD 

2.3.2. Hàn điện trở dán, tụ dán 

❖ Thực hiện 

- Bước 1: Xi chì hàn lên một điểm hàn trên mạch. Chú ý không xi chì 

hàn lên nhiều điểm hàn. Làm như vậy tránh việc nhiều chì hàn dễ đội linh 

kiện lên gây mất thấm mỹ. 

 

Hình 1.12 

- Bước 2: Dùng panh gắp linh kiện đặt vào điểm cần hàn. Chú ý phải 

đặt đúng vào vị trí. Một tay dùng panh ấn nhẹ lên linh kiện để giữ cho linh 

kiện ở đúng vị trí không xê dịch.  

- Bước 3: Dùng mỏ hàn hàn điểm đầu đã được xi chì hàn trước đó để cố 

định linh kiện. Sau đó hàn tiếp đầu còn lại. 
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Hình 1.13 

 

2.3.3 Hàn IC dán 

- Bước 1: Kiểm tra vị trí đặt IC. 

- Bước 2: Hàn 2 chân ở hai góc của linh kiện để cố định. 

 

Hình 1.14 

- Bước 3: Sau khi linh kiện đã được cố định, cho một ít nhựa thông vào các 

chân linh kiện. Nhựa thông sẽ làm mối hàn bóng đẹp và làm sạch bụi củng 

như chống oxy hóa sau khi hàn. 

 

Hình 1.15 
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Bước 4: Tiếp theo là hàn tất cả các chân còn lại của linh kiện. 

 

Hình 1.16 

Bước 5: Dùng dây hút chì nhúng vào nhựa thông sau đó đặt dây đồng vào 

giữa hai chân linh kiện bị dính nhiều chì. Nung nóng dây và chì hàn ở điểm 

này, dây đồng sẽ hút bớt chì ở vị trí này và sẽ tách hai chân linh kiện ra. 

 

Hình 1.17 

 Sau khi hút xong chì ta được kết quả như sau 

 

Hình 1.23 
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3. Phương pháp xử lý mạch sau hàn 

3.1. Yêu cầu về mạch, linh kiện sau hàn 

 Mạch in sau khi hoàn thiện phải đạt được một số yêu cầu sau: 

- Mach in nhìn bằng mắt thường phải đẹp, linh kiện bố trí hợp lý, đơn giản. 

- Linh kiện trong mạch phải được thay thế dễ dàng khi bị hỏng. 

- Mạch hoạt động phải ổn định. 

- Mối hàn phải bền, đẹp, không bị dính sang mối hàn khác. 

 

 

3.2. Phương pháp xử lý mạch sau hàn 

 Sau khi làm xong tất cả các bước thì ta tiến hành test mạch bằng cách dùng 

đồng hồ VOM hoặc đồng hồ điện tử để kiểm tra thông mạch và các thông số khác 

của mạch in. 

- Kiểm tra đường in nguồn điện trên mạch. 

- Kiểm tra linh kiện của mạch in đã được hàn. 

- Kiểm tra và test hoạt động của mạch. 

Hoàn thiện mạch và đưa vào hoạt động. 
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BÀI 6: CHẾ TẠO MẠCH IN 

Giới thiệu: 

 Sinh viên cần được trang bị kiến thức về thiết kế mạch để tự thực hành 

thiết kế và hoàn chỉnh một số mạch điện thông dụng bằng phương pháp bằng tay. 

Việc thiết kế và chế tạo mạch in cần sinh viên nắm bắt được kỹ thuật hàn linh kiện 

và khối lượng kiến thức tương đối lớn về các linh kiện điện tử: điện trở, tụ điện...và 

một số IC: 555, CD4017, MSC51,...Vì vậy,thiết kế và chế tạo mạch in là sự tổng 

hợp kiến thức của sinh viên về điện tử,diều này giúp người dạy có cơ sở để đánh 

giá năng lực của sinh viên trong qua trình học. 

Mục tiêu: 

      - Chế tạo được các mạch in của các mạch điện tử đơn giản đạt yêu cầu kỹ thuật.. 

      - Rèn luyện tính tỷ mỉ, chính xác, an toàn và vệ sinh công nghiệp 

1.  Chuẩn bị thiết bị  vật tư. 

- Board đồng hay còn gọi là mạch in, phím đồng... 

- Testboard. 

- Thuốc rửa sắt 2 clorua (Fe2Cl3). 

- Mạch in đã được in sẵn trên giấy. 

- Bút lông dầu. 

- Bàn ủi. 

- Cưa. 

- Dùng khoan tay cho dễ khoan. 

- Axeton hoặc cồn. 

- Thước kẻ. 

- Khay nhựa dùng để rửa Board đồng. 

.2.  Các bước chế tạo 

2.1. Vẽ bằng tay 

❖ Bắt đầu. 

Sau khi đã có mạch in thiết kế trên các phần mềm vẽ mạch thì ta sẽ dựa vào đó 

để vẽ mạch lên phôi PCB. Đối với các board mạch có những linh kiện nhiều hơn 2 

chân, thì khi làm mạch ta phải Mirror mạch điện, bằng cách dùng phần mềm in ảo 

để in ra file .pdf. Các tùy chọn khi in dùng phấn mềm Orcad Layout (xem hình 

2.4).  
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Hình 2.4 

 Sau đó, dùng phần mềm in ảo Microsoft Office  để tạo file .pdf (xem  

hình 2.5) 

 
Hình 2.5 

 Kết quả hình 2.6 
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Hình 2.6 

Đầu tiên chúng ta cần sử dụng một bản Testboard để đánh dấu các điểm sẽ 

khoan mạch vì  nó có sẵn lỗ cố định để chúng ta đánh dấu chuẩn khoảng cách, đảm 

bảo gắn vừa linh kiện (nhất là IC) ( xem hình 2.7). 

 

Hình 2.7  Testboard 

Đặt cố định PCB lưới lên phôi PCB cần vẽ mạch (xem hình 2.8). 
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hình 2.8 

Dùng bút lông  để chấm lỗ xác định tại những vị trí của linh kiện cần thiết ứng 

với vị trí lỗ của testbord (xem hình 2.9). 

 
Hình 2.10  Bút lông dầu 

Để đánh dấu các chân linh kiện một cách chính xác, ta dựa vào sơ đồ mạch in 

đã Mirror, tránh trường hợp đặt các linh kiện gần nhau vì có thể gây ra lỗi linh kiện 

chồng lên nhau. Hình  2.11 là kết quả sau khi được đánh dấu. 
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Hình 2.11  

Sau khi đã định vị các chân linh kiện, ta dùng bút lông dầu vẽ các chân linh 

kiện theo hình 2.12 dưới đây. 

 
Hình 2.12  

 

Tiếp theo, ta dùng thước kẽ để vẽ các đường dây dẫn để nối các chân linh kiện 

cần nối theo sơ đồ mạch điện xem hình 2.13. 
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Hình 2.13 mạch sau khi vẽ  

Sau khi hoàn thành công đoạn chấm, vẽ, kẻ thì kiểm tra lại theo sơ đồ tạo ra từ 

phần mềm (đã nhắc ở trên), nếu chỗ nào sai cần dùng bông gòn (hay dùng vệ sinh 

tai mũi ) tẩm cồn hoặc axeton để tẩy và vẽ lại hình 2.14. 

 

 
Hình 2.14 cồn hoặc axeton 

- Bây giờ chúng ta ngâm PCB vào dung dịch Fe2Cl3 (dùng bột sắt pha với 

nước) . Chú ý vừa ngâm vừa lắc cho tốc độ tan lớp mạ đồng diễn ra nhanh hơn   ( 

xem hình 2.15).                                                                                                
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Hình 2.15. Rửa mạch bằng Fe2Cl3  

Mạch sau khi đả rửa hết lớp đồng hình 2.16. 

 

Hình 2.16. Mạch in sau khi rửa 

Phần mạch in là lớp đồng không bị hòa tan nằm dưới lớp mực mà ta đã vẽ. 

Tiếp theo dùng axeton hoặc cồn. Tẩm axeton vào bông gòn và lau mạch cho sạch 

lớp mực. Cuối cùng chúng ta dùng khoan để khoan lỗ mạch, hàn linh kiện và test 

bord mạch xem hình 2.14. 
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Hình 2.17 

2.2.2. Làm mạch in bằng phương pháp ủi 

- Phương pháp này là dùng mạch đã được in sẵn trên giấy, sau đó đặt lên phím 

đồng và dùng bàn ủi để ủi, lúc này do tác dụng nhiệt làm nóng chảy mực in trên 

giấy và dính vào phím đồng. 

Tạo file in (xem hình 2.23) 

Dùng các phần mềm vẽ mạch để vẽ mạch in như Orcad, Proteus...sau khi vẽ 

mạch xong ta đem di in ra giấy. 

 

 
Hình 2.23. File layout dùng để in mạch 
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- Cắt phần mạch in trên giấy cho sát kích thước cần làm. 

- Cắt một tấm board đồng bằng với kích thước trên. 

- Úp phần giấy phía mực đè lên mặt đồng. Làm sao cho vừa vặn, đừng chà qua 

chà lại. Để cả hai lên một tấm gỗ phẳng hay vật gì khác để làm đế. 

- Bàn ủi cắm điện và để mức nóng cao nhất. 

- Đặt bàn ủi đè lên lớp giấy và tấm đồng ban nãy. Đè mạnh và cố định tại chỗ 

trong khoảng 30 giây cho lớp keo trong mực in chảy ra và bám dính vào mặt đồng. 

- Miết bàn ủi đều trên diện tích board để đảm bảo tất cả mực in đều bị nóng 

chảy. Thời gian còn tùy vào kích thước board, độ nóng và lực miết xem hình 2.19.  

- Để board chỗ thoáng cho nguội đi hoàn toàn. 

 

 

 
Hình 2.19.  Dùng bàn là để ủi mạch 

Gỡ lớp giấy in (hình 2.20) 

- Pha một thau nước xà phòng đủ để ngâm phủ toàn bộ board. 

- Bỏ board vào ngâm khoảng 20 phút. 
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Hình 2.20 Ngâm mạch trong xà phòng 

 

- Lấy board ra. Lúc này lớp giấy sẽ bị phân hủy và tróc ra xem hình 2.21. 

 

 
Hình 2.21 Mạch sau khi ngâm xà phòng 

- dùng tay gở nhẹ lớp giấy cho đến khi giấy trên bề mặt mạch in hết sạch xem 

hình 2.22. 
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Hình 2.22  Mạch sau khi gỡ giấy 

Do trong quá trình gỡ và ủi có nhiều chỗ mạch bị xước khơng có mực nên ta 

dùng bút lông dầu tô lại những chỗ nào không có mực để khi làm xong mạch 

không bị rỗ hay bị đứt mạch. 

Rửa mạch in (xem hình 2.23) 

Dùng thuốc rửa pha với nước. Sau khi pha xong thì ta cho mạch in vào dung 

dịch này sau đó lắc đều cho mạch in bị ăn  hết lớp đồng không cần thiết ra. 

 
Hình 2.23 Rửa mạch in 

Khi lớp đồng bị ăn hết, ta lấy ra rửa sạch bằng nước và để cho khô hoặc sấy 

khô, dùng giấy nhám nhuyễn chà lớp mực in trên board cho sạch xem hình 2.24. 
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Hình 2.24. Mạch sau khi rửa Fe2Cl3 

 

 Khoan mạch in:      

Dùng khoan tay để khoan (có thể dùng khoan máy) với các linh kiện thường 

như trở, tụ, IC thì ta dùng mũi 0.8mm còn đối với IC 78xx, triac... thù ta dùng mũi 

1.2mm...hình 2.25 

 

Hình 2.25 mạch in đả được khoan lổ 

Bước 6: Hàn linh kiện và test mạch. 

sau khi làm xong tất cả các bước thì ta tiến hành hàn linh kiện và test mạch. 

2.3.  Hoàn thiện mạch in 

Sau khi vẽ hoàn chỉnh sơ đồ mạch in trên giấy, chúng ta bước sang giai đoạn 

thực hiện mạch in. Trình tự thực hiện tiến hành theo các bước sau: 

Bước 1: Dùng giấy nhám nhuyễn đánh sạch lớp oxit hóa đang bám trên tấm mạch 
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in (phía có tráng lớp đồng), trước khi vẽ các đường mạch. 

Bước 2: Tạo đường mạch in trên mặt đồng có các phương pháp sau: 

- In mạch in đã vẽ ra giấy để in lụa hoặc ép nhiệt để tạo mạch in trên 

đồng. 

- Dùng viết lông có dung môi acetone để vẽ nối các đường mạch trên mặt  

đồng (dựa theo các điểm pointou vừa định vị và sơ đồ mạch đã vẽ trước trên giấy). 

Trong khi vẽ ta chú ý, có hai phương pháp để vẽ điểm pad hàn trên mạch in. 

Điểm pad hàn có thể vẽ theo hình tròn hoặc hình vuông. Thông thường điểm pad 

tròn dễ thực hiện nhưng lại kém tính mỹ thuật hơn điểm pad vuông.Muốn thực 

hiện điểm pad vuông, ta có thể dùng viết tô rộng (quanh vị trí cần tạo điểm pad 

vuông), sau đó dùng đầu mũi dao nhọn và thước kẻ tỉa bớt mực để duy trì một 

vùng mực bám hình vuông cho điểm pad cần thực hiện. Công việc này đòi hỏi 

nhiều thời gian và sự tỉ mỉ khi thực hiện. 

- Sau khi đã tạo các đường mạch trên mặt đồng của mạch in, ta quan sát xem 

có vị trí nào bị vẽ không liền nét, độ đậm của các đường phải đều nhau, đồng thời 

không bỏ sót đường mạch nào cả. Trong trường hợp cần thiết, sinh viên phải chờ 

cho mực khô hẳn rồi đồ lại một lần nữa. 

Bước 3: Sau khi vẽ hoàn chỉnh, sinh viên chờ khô mới mang mạch in nhúng 

vào thuốc tẩy. Hóa chất tẩy sẽ ăn mòn lớp đồng tại các vị trí không bám mực và sẽ 

để nguyên lớp đồng tại các vị trí được bao phủ bằng các đường vẽ mực. Khi 

nhúng mạch in trong thuốc tẩy, muốn phản ứng hóa học xảy ra nhanh, cần thực 

hiện các thao tác sau để tăng tốc độ phản ứng: 

- Lắc tấm mạch trong chậu thuốc. 

- Nên đặt chậu thuốc tẩy nơi có ánh sáng mặt trời để tăng cường tốc độ phản 

ứng nhờ hiệu ứng quang. 

- Nếu thuốc tẩy được nung nóng khoảng 50oC thì thời gian tẩy sẽ nhanh hơn 

khi thuốc tẩy có nhiệt độ thấp (bằng nhiệt độ môi trường). 

Bước 4: Sau khi tẩy xong các phần đồng không cần thiết, nên ngâm mạch vào 

trong nước lã và dùng giấy nhám nhuyễn chà sạch các đường mực đã vẽ. Công việc 

sẽ chấm dứt khi các đường mạch được đánh bóng và sáng. 

Trước khi dùng nhựa thông lỏng phủ bảo vệ lớp đồng, ta dùng khoan (đường 

kính lưỡi khoan khoảng 0,8 -1mm) để khoan các lỗ ghim linh kiện. Trong một vài 

trường hợp, ta có thể dùng máy dập bấm lỗ thay vì khoan. Tuy nhiên, lỗ dập không 

tròn và khi dập dễ làm mẻ lớp bakelite nhưng tốc độ thi công nhanh hơn, và dễ thao 

tác hơn phương pháp khoan. 

Bước 5:  

Sau khi khoan (hay dập) lỗ xong, cần đánh sơ lại một lần mạch in (phía có các 

đường đồng) bằng giấy nhám nhuyễn, làm sạch lớp oxit hóa lần cuối rồi mới 

nhúng tấm mạch vào dung dịch nhựa thông pha với xăng và dầu lửa. Khi nhúng 
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xong mạch, để ráo và phơi khô lớp sơn phủ rồi mới hàn linh kiện lên mạch. 

Chọn mũi khoan phù hợp với lỗ chân cắm không được chọn to quá sẽ làm mất  

hết phần bao của lỗ và khoan cẩn thận tránh rách mạch. Khi cúng ta đã khoan hết 

các lỗ khoan rồi đi rửa lại toàn bộ mạch cho sạch. Đầu tiên dùng axeton để rửa sạch 

lớp mực bám lên phíp đồng. Khi đó để lại đường mạch đẹp và sáng. 

Khi đã loại bỏ hết lớp mực thì phải bảo vệ lớp đồng để tránh bị oxy hóa.  Bằng 

cách quét một lớp mỏng nhựa thông pha sẵn. 

Hoàn thành: 

- Khoan các lỗ chân linh kiện. 

- Pha dung dịch bảo vệ: nhựa thông hòa tan trong xăng. 

- Dùng chổi quét dung dịch nhựa thông lên mặt đồng. 

- Đem phơi cho đến khi bế mặt khô hoàn toàn. 

 

 

 


